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Самостоятельная работа «Верификация технологи-
ческих операций сборки» 

Цель работы 

С помощью программного комплекса DELMIA DPM Assembly про-
вести построение и верификацию технологических операций сборки из-
делия и ознакомиться со способами: 

• задания типовых сборочных операций в системе DELMIA DPM 
Assembly; 

• учета используемого оборудования и приспособлений; 
• представления процессов сборки (схем сборки); 
В результате выполнения самостоятельной работы студенты долж-

ны приобрести навыки разработки технологических процессов сборки в 
среде DELMIA DPM Assembly. 

Введение 

В настоящее время предприятия должны постоянно повышать про-
изводительность для того, чтобы успешно конкурировать на рынке. Для 
этого требуются сокращение сроков поставок, уменьшение текущих 
расходов, оптимальное использование производственных мощностей, 
оптимизация материальных и информационных потоков. В то же время 
полная автоматизация, определенная ранее как конечная цель, заменяет-
ся гибридной схемой, которая автоматизирована частично, вследствие 
чего она легко приспосабливаема к производственной системе.  

Решением задач исследования, планирования и оптимизации про-
цессов изготовления и обслуживания изделий на предприятии до начала 
их реального производства занимается система DELMIA.  

Программный комплекс DELMIA решает следующие основные за-
дачи: 

• планирование производственных процессов; 
• планирование производственных помещений; 
• анализ эргономичности производственных процессов; 
• оптимизация производственных процессов; 
• контроль качества, нормирование; 
• симуляция работы конвейеров; 
• симуляция работы промышленных роботов и роботизирован-

ных ячеек; 
• симуляция и верификация технологических процессов сборки 

и др. 

 6



В рамках данного пособия будет рассмотрен модуль DELMIA DPM 
Assembly, который позволяет моделировать технологические процессы 
сборки, проводить верификацию сборочного процесса, анализировать 
собираемость изделия, оценивать производственные ресурсы, исполь-
зуемое оборудование, инструмент и приспособления, рассчитывать вре-
менные характеристики технологических операций сборки. 

Виртуальное моделирование позволяет оптимизировать используе-
мые ресурсы и схему размещения оборудования в цехе или на производ-
ственном участке. Пользователь имеет возможность манипулировать как 
составом, так и взаимным расположением производственных компо-
нент, быстро изменяя и совершенствуя схему их размещения. Сочетание 
DPM Assembly с другим модулем – DPM Work Instruction дает возмож-
ность генерировать так называемые электронные рабочие инструкции. 
Эти инструкции могут включать в себя симуляции различных этапов 
сборки и использоваться рабочими производственных цехов и участков. 

Система DELMIA использует единую модель данных PPR (Process, 
Product, Resource), которая объединяет всю необходимую информацию 
об изделии (продукте), процессах изготовления или обслуживания, а так 
же о используемых ресурсах. В единой информационной среде объеди-
няются данные, используемые инженерами-конструкторами, инженера-
ми-технологами, технологами, инженерами по организации производст-
ва, специалистами по планированию производства. Любая единица ин-
формации, 

важная в контексте интегрированного инжиниринга продукта и 
процесса, может быть найдена в модели данных PPR. 

DELMIA полностью интегрируется с системой CATIA, предназна-
ченной в первую очередь для проектирования изделия, а также с PDM-
системами (напр., ENOVIA Smarteam). 
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Задание 

В данной работе студентам необходимо самостоятельно выполнить 
верификацию и оптимизацию технологических операции сборки. Для 
этого необходимо следовать следующему плану. 

Этап 1. Формирование рабочего места.  

До начала непосредственного задания технологического процесса 
сборки необходимо сформировать рабочее место и указать используе-
мые ресурсы. Ресурсы – любые элементы, которые будут использоваться 
на конкретном рабочем месте при сборке изделия. Ресурсы могут хра-
ниться как в библиотеках, так и локально на компьютере пользователя 
(это определяется стандартами организации работ на конкретном пред-
приятии). 

1. Запустите систему DELMIA. 
2. Перейдите к модулю DPM Assembly Process Simulation (меню 

Start / Digital Process for Manufacturing / Assembly Process Simulation), 
рис. 1. 

 

Рис. 1. Запуск DPM Assembly Process Simulation 

 8



3. В данном задании ресурсы будут добавляться из каталога. 
4. Щелкните на иконке Catalog Browser (рис. 2). 

 

Рис. 2. Обращение к каталогу 

Нажав на кнопку browse another catalog, выберите каталог 
../Dassault Systemes / B17 / intel_a / startup / components / facility / 
furniture.catalog             (рис. 3). 

 
Рис. 3. Режим поиска каталога элементов 
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Из открывшегося каталога выберите стол work_bench 72x36x34. 
Добавьте два таких стола и расположите их относительно друг дру-

га, как показано на рисунке ниже. 

 

Рис. 4. Подготовка виртуального рабочего места 

Из каталога My_Catalog.catalog (находится в папке с данными для 
самостоятельной работы) добавьте стул (chair) и тележку для инстру-
ментов (toolcart). 

Добавьте используемый инструмент – гаечный ключ (wrench) и от-
вертку (screwdriver). Расположите компоненты относительно друг друга, 
как показано на рис. 5. 

Далее необходимо добавить изделие (продукт) в созданное окруже-
ние. 

Для этого воспользуйтесь командой Insert Product в меню Insert или 
на панели инструментов. 
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Рис. 5. Выбор инструментов сборки 

В открывшемся окне проводника Windows выберите файл 3.5 HP 
engine.CATProduct в папке с данными для самостоятельной работы (Pro-
ject Data/ Product). 

Расположите изделие (3.5 HP engine.CATProduct) на рабочем столе 
(рис. 6). 

 
Рис. 6. 3.5 HP engine.CATProduct 
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Сохраните созданное рабочее место в папку, указанную преподава-
телем. 

Этап 2. Создание библиотеки стандартных технологиче-
ских сборочных операций 

В процессе работы используется Process Library – библиотека стан-
дартных операций, которая включает в себя описание всего множества 
операций, используемых в процессе замены компонента. Данная библио-
тека может формироваться как заранее, так и в процессе работы. Струк-
тура и иерархия, а также параметры конкретных операций должна опре-
деляться существующими на предприятии нормативными документами, 
стандартами и пр. 

Создадим новую библиотеку операций. Меню File-New-Process 
Library.  

Выберите команду Create New Activity  и назовите “Engine 
assembly” (Сборка двигателя). 

Выберите команду Create New Activity Subtype  для создания 
подтипов операций. 

Создайте следующие подтипы (операций): 
• Intake Valve Assy (установка впускного клапана), 
• Carburetor Assy (установка карбюратора),  
• Air Filter Assy (установка воздушного фильтра), 
• Crankshaft Assy (установка коленчатого вала), 
• Piston Assy (установка поршня), 
• Piston Rod Assy (установка поршневого штока), 
• Cam Assy (установка кулачка),  
• Crankcase Assy (установка картера),  
• Flywheel Assy (установка маховика),  
• Cover Assy (установка крышки). 

 

Рис. 7. Технологический процесс сборки 
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Сохраните вашу библиотеку операций в папку, указанную препода-
вателем (например, …/ Project Data / my process library). 

Далее ассоциируем созданную библиотеку с процессом сборки 
(Process). Для этого необходимо воспользоваться инструментом Insert 

Activity Library  и указать Process в дереве проекта, после чего вы-
брать ранее созданную библиотеку. 

Это необходимо для того, чтобы при задании операций система 
предлагала нам список операций из библиотеки. 

Этап 3. Формирование перечня технологических операций 
(последовательности сборки) 

Следующим этапом работы является формирование последователь-
ности сборки. Это делается путем добавления технологических опера-
ций (Activity) в дерево проекта (в ветвь Process).  

Как правило, последовательность формируется в обратном порядке 
(т.е. производится разборка изделия), а после этого порядок операций 
меняется на противоположный. 

Для добавления операций воспользуйтесь инструментом Insert Ac-

tivity , щелкните на Process и выберите Engine Assembly в появив-
шемся диалоговом окне. 

Далее с помощью того же инструмента добавьте Block Assy, выбрав 
тип вставки Add As child (вставить, как потомка). 

Затем добавьте остальные операции, выбирая тип вставки Add As 
Successor (вставить, как последующий элемент). Последующий элемент 
(Sacsessor) должен быть связан с предыдущей операцией, а не с Engine 
Assembly.  

Теперь необходимо проверить правильность последовательности 
операций и при необходимости изменить ее. Сделать это можно с по-
мощью диаграммы планирования с использованием сетевого графика 
(PERT chart). 

Щелкните на иконке Open Pert Chart  , а 
затем на Process в дереве проекта. Откроется сетевой график вашего 
процесса. Раскройте полностью график, нажав “+” в правом верхнем уг-
лу Engine Assembly.  
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Рис. 8. Задание последовательности операций сборки 

Стрелки обозначают связи между операциями. Задайте последова-
тельно связи между всеми  операциями,  используя инструмент  Link Se-
lected Activities 

. 
Ваш процесс должен выглядеть, как показано ниже. 
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Рис. 9. Отображение  процесса сборки 

С помощью диаграммы планирования можно задавать параллель-
ные процессы, используя логические операции. 

Теперь необходимо сопоставить операциям соответствующие дета-
ли, т.е. указать системе какая именно деталь (или сборка) устанавлива-
ется на данной операции. Для этого выделите подсборку Block Assembly 
в дереве проекта (ветвь ProductList), щелкните на иконке  Assign an item 

, а затем на операции Block Sub Assembly (ветвь ProcessList). 
Раскройте ветвь Block Sub Assembly в дереве, чтобы убедиться, что 

операция проведена успешно. 

Этап 4. Задание траектории перемещения компонентов и 
анализ пересечений компонентов 

Задание траектории перемещения компонентов является одним из 
ключевых моментов при создании технологических процессов сборки.  

Поскольку мы работаем в виртуальной среде, то перемещение лю-
бого компонента может быть создано независимо от других компонен-
тов. После чего может быть проведен анализ на столкновения и взаим-
ные пересечения компонентов.  

Зададим траектории перемещения для следующих компонентов:  
• Cover (Кожух) 
• Air Filter (Воздушный фильтр)  

Выполните следующую последовательность действий: 
1. Выделите операцию, для которой вы хотите задать переме-

щение. 
2. Создайте перемещение с помощью инструмента Move Activity 

 и выберите тип вставки as child. 
3. Убедитесь, что в окне предварительного просмотра выбрана 

правильная деталь (сборка), нажмите OK в окне Edit Shattle. 
4. Перетащите деталь в сторону от двигателя, используя компас. 

5. Зафиксируйте положение, нажав кнопку Record . 
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6. Повторяйте предыдущее действие, пока не уложите деталь на 
стол. 

7. Фиксируйте каждое положение детали, нажав на кнопку 
Record. 

8. Используйте панель инструментов Player для отмены и про-
смотра перемещений. 

9. Когда убедитесь, что деталь имеет необходимое положение 
(лежит на столе), закройте диалоговое окно Track и повторите 
те же действия для других деталей. 

После того, как траектории построены для необходимых деталей, 
мы можем посмотреть симуляцию всего процесса и определить места 
возникновения проблемных участков, представляющих собой столкно-
вения компонентов и их взаимное пересечение. 

Включите опцию Clash Detection (Stop) , запустите симуля-
цию процесса, используя команду Compile Simulation: 

. 
После чего запустите симуляцию, используя панель Player: 

 
Система должна автоматически определить столкновения компо-

нентов и остановить симуляцию в момент возникновения конфликта, 
подсветив красным цветом место столкновения (рис. 10). 
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Рис. 10. Визуализация столкновений в DELMIA 

Этап 5.Формирование файла отчета 

Формат файла отчета настраивается для каждого конкретного пред-
приятия в соответствии с его стандартами и потребностями. 

В рамках данной работы предлагается воспользоваться стандартной 
формой файла отчета, поставляемой с дистрибутивом системы DELMIA. 

Вся необходимая документация генерируется системой на основе 
скриптов (CATScript, VBScript), что дает практически неограниченные 
возможности по заданию формы отчетов, формата (и выводу всех необ-
ходимых параметров). Для вывода файла документации воспользуйтесь 

инструментом Generate Documentation . 
В появившемся диалоговом окне выберите скрипт, нажав на кноп-

ку Browse. Путь к файлу (рис. 11):  
../CATIA/B17/intel_a/code/command/DocumentGeneratorHTML_WNT_DPM
WorkImages.CATScript. 
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Рис. 11. Генерация документации 

В поле Path укажите путь для сохранения файла отчета и имя в по-
ле Main File Name. Нажмите OK  для создания файла отчета. На сле-
дующем рисунке представлен пример такого отчета. 

 

Рис. 12. Форма отчета 
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Самостоятельная работа «Применение метода ко-
нечных элементов в системах MSC Nastran и Patran» 

Компьютерные технологии инженерного анализа и 
виртуального моделирования 

В настоящее время разработчики всех видов техники достигли зна-
чительных успехов в повышении производительности, скорости, грузо-
подъемности, безопасности, экологичности, комфортабельности при од-
новременном снижении материало- и энергоемкости своей продукции. 

Однако, созданием хорошего изделия задача, стоящая перед пред-
приятием, не исчерпывается. Как показывает мировой опыт, острая  ры-
ночная конкуренция вынуждает  проводить разработку в кратчайшие 
сроки, с наименьшим объемом экспериментальной доводки, не снижая 
при этом качества и потребительских свойств своей продукции. Веду-
щие производители видят выход в широком внедрении новых техноло-
гий  в процесс разработки и подготовки производства сложной наукоем-
кой продукции. Одним из важнейших приоритетов в этом направлении 
является  использование компьютерного моделирования при разработке 
изделий и технологических процессов, позволяющее значительно сокра-
тить сроки цикла «проектирование - производство», существенно сни-
зить число опытных образцов и натурных испытаний. Практическая реа-
лизация такого подхода базируется на технологии проектирования, ос-
нованной на масштабном математическом моделировании и вычисли-
тельном эксперименте. 

Современный уровень компьютерного моделирования позволяет 
оценить, исследовать и оптимизировать каждый компонент нового изде-
лия в компьютерной, виртуальной среде, до изготовления дорогостоя-
щих реальных прототипов. При этом проектирование сложных совре-
менных конструкций, как правило, требует совместного использования 
широкого набора различных систем инженерного анализа, ответствен-
ных за тот или иной этап расчетного сопровождения проекта (анализ 
движений, кинематики, моделирование систем контроля, огромный спи-
сок задач от термо- и газовой динамики до анализа ударных и акустиче-
ских процессов).  

Обширный выбор систем инженерного анализа, представленный на 
рынке различными компаниями, ставит пользователей в трудное поло-
жение. Трудно обеспечить взаимодействие разрозненных систем друг с 
другом, сложно обеспечить их согласованное совместное использование 
в проекте. Поэтому, наряду с повышением функциональных качеств 
расчетных систем, актуальной темой последнего времени является обес-
печение их взаимодействия и интеграции.  
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Такая интегрированная среда, когда пользователь может легко при-
менить нужные ему системы совместно, комплексно, является гораздо 
более ценной и эффективной, чем наличие набора разрозненных, совер-
шенно разных, плохо совместимых программ специфического назначе-
ния.  

Стратегия виртуальной разработки изделия (VPD – Virtual Product 
Development) – это интегрированная среда систем инженерного анализа. 
Системы VPD являются фактически проверенным международным 
стандартом для всех видов инженерного моделирования, включая мно-
годисциплинарные приложения. Интегрированная среда систем инже-
нерного анализа интенсивно используется ведущими предприятиями 
мировой индустрии, позволяя им выпускать лучшие изделия, сокращать 
сроки проектирования и получать максимум прибыли в жесткой конку-
рентной борьбе.  

Действительно, сегодня каждая из систем VPD, взятая в отдельно-
сти, обеспечивает достаточную функциональность в тех или иных инже-
нерных приложениях (например, системы анализа кинематики, различ-
ные конечно-элементные системы, пре- и постпроцессоры, системы 
управления процессами и т.д.). Каждая компонента, каждая система мо-
жет использоваться индивидуально, изолированно от других продуктов. 
Но только комбинированное, комплексное использование систем может 
раскрыть их полный потенциал.  

VPD системы обеспечивают гибкое управление и эффективное рас-
пределение информации, легкий обмен данными между системами, без 
промежуточных стадий конвертации и адаптации данных. Геометриче-
ская информация оптимально передается от одного процесса к другому, 
и результаты одного расчета органично становятся исходными данными 
для следующего шага инженерного моделирования. Наряду с геометри-
ей, обеспечивается передача данных по нагрузкам, всевозможным гра-
ничным условиям и т.д.  

Каждая система имеет специфические, отличные от других систем 
инструменты и пользовательский интерфейс, однако общая среда, общ-
ность подходов, логичность, связность, легкость взаимодействия между 
системами, обеспечивают пользователю возможность работы с любой из 
них без длительного переучивания. Адаптивная, гибкая среда VPD сис-
тем позволяет легко переключаться на решение новых типов задач. Осо-
бо следует отметить удобство моделирования процессов, требующих 
использования не одной, а нескольких расчетных систем. Интегриро-
ванная среда VPD продуктов – идеальный инструмент для решения та-
ких сложных, многодисциплинарных проблем. Кроме того, рассматри-
ваемые системы дают возможность компьютерного моделирования из-
делия в сборе с учетом всех эксплуатационных нагрузочных параметров. 
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Этот подход позволяет достоверно исследовать функционирование каж-
дого компонента конструкции в составе всего изделия, а это в свою оче-
редь позволяет осуществлять интеграцию информации не только на 
уровне подразделений предприятия-разработчика, но и обмен информа-
цией на уровне предприятий-смежников. 

MSC.Patran - интегрированная среда 
моделирования, анализа и проектирования 

MSC.Patran – программный продукт компании MSC.Software, 
обеспечивающий интеграцию автоматизированных систем 
проектирования, моделирования, анализа и оценки результатов 
расчетов. Использование Patran в комбинации с другими программными 
продуктами позволяет достичь наибольшей эффективности в оценке 
работоспособности и оптимальности конструкции изделий при их 
разработке, производстве и эксплуатации еще до того, как начнутся 
изготовление и испытания опытных образцов. 

Patran располагает развитыми средствами генерации конечно-
элементных сеток, что придает этому процессу гибкость и высокую 
степень автоматизации. Нагрузочные и граничные условия могут быть 
увязаны как с геометрическими, так и с конечно-элементными 
моделями. Развитые средства визуализации помогают ускорить и 
повысить качество анализа полученных результатов расчета. 

При использовании Patran основой создаваемой конечно-
элементной модели является, как правило, геометрическая модель. 
Поэтому Patran предоставляет прямой доступ к результатам 
геометрического моделирования в наиболее популярных в мире 
программных пакетах автоматизированного проектирования или к 
универсальным форматам обмена данными при отсутствии прямых 
интерфейсов. Patran имеет также собственные обширные возможности 
создания и модифицирования геометрических моделей, контроля CAD-
геометрии и преобразования ее перед построением конечно-элементной 
модели. 

Patran используется не только для работы с расчетными системами 
компании MSC.Software, он на высоком уровне интегрируется и с 
системами анализа многих других разработчиков. 
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MSC.Nastran - расчет и оптимизация конструкций 

Главный продукт компании MSC.Software - Nastran - это одна из 
лучших на рынке конечно-элементных систем. В сфере, где ненадежные 
результаты могут обернуться миллионами долларов дополнительных 
расходов на разработку, Nastran вот уже более 40 лет доказывает свою 
точность и эффективность. Постоянно развиваясь, он аккумулирует в 
себе достоинства новейших методик и алгоритмов конечно-элементного 
анализа. 

MSC.Nastran обеспечивает практически полный набор расчетов, 
включая расчет напряженно - деформированного состояния, 
собственных частот и форм колебаний, анализ устойчивости, решение 
задач теплопередачи, исследование установившихся и 
неустановившихся процессов, нелинейных статических процессов, 
нелинейных динамических переходных процессов, расчет критических 
частот и вибраций роторных машин, анализ частотных характеристик 
при воздействии случайных нагрузок, спектральный анализ и 
исследование аэроупругости. Предусмотрена возможность 
моделирования практически всех типов материалов, включая 
композитные и гиперупругие. Расширенные функции включают 
технологию суперэлементов (подконструкций) и макроязык DMAP для 
создания пользовательских приложений. 

Наряду с расчетом конструкций Nastran может использоваться и 
для оптимизации проектов. Это делается путем вариации параметров 
формы, размеров и свойств проекта. Благодаря своей эффективности 
алгоритмы оптимизации обрабатывают неограниченное число 
проектных параметров и ограничений. Вес, напряжения, перемещения, 
собственные частоты и многие другие характеристики могут 
рассматриваться либо в качестве целевых функций проекта (в этом 
случае их можно минимизировать или максимизировать), либо в 
качестве ограничений. Алгоритмы анализа чувствительности позволяют 
исследовать влияние различных параметров на поведение целевой 
функции и управлять процессом поиска оптимального решения. Nastran 
применяется также и для планирования экспериментов (определения 
мест расположения датчиков) и оценки полноты полученных 
экспериментальных данных. 
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Задание 

Студентам необходимо самостоятельно создать в CAD-системе 3-D 
модель детали, а также задать исходные данные, необходимые для 
выполнения расчета: свойства материала, величина и точки приложения 
нагрузки, граничные условия. 

Для проведения инженерного расчета в MSC.Nastran  и MSC.Patran 
необходимо выполнить следующие действия: 

1. Создать новую базу данных.  
2. Импортировать геометрию из CAD-системы. 
3. Создание поверхности с сеткой конечных элементов.  
4. Задать нагрузку и граничные условия. 
5. Создать материал. 
6. Задать физические свойства. 
7. Задать нагрузки и граничные условия. 
8. Выполнить анализ в системе MSC.Nastran. 
9. Обработка результата постпроцессором. 

Создание базы данных 

Для того чтобы начать работу в системе MSC.Patran необходимо 
создать базу данных.  

1. В главном меню выбрать File > New. Появится панель New > 
Database. 

2. Ввести в текстовое поле File Name имя базы данных. Нажать 
ОК. 

3. Появится New Model Prference – панель для указания 
общих параметров модели (рис. 13). В этой панели можно 
задать точность создания модели (Tolerance) или оставить 
значения по умолчанию (Default). 

4. Необходимо убедиться, что к системе MSC.Patran 
подключена вычисляющая программа MSC.Nastran, которая 
указана в разделе Analysis Code. Если имеется лицензия 
можно подключить другие программы. 

5. Выбрать в разделе Analysis Type > Structural и нажать Ok. 
База данных будет создана, но она будет пустая. 
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Рис. 13 Панель для указания общих параметров модели 

Импорт геометрии из CAD-системы 

На данном этапе выполнения работы необходимо  импортировать 3-
D модель детали в систему MSC.Patran. Для этого следует в главном ме-
ню выбрать File > Import и указать импортируемый файл модели. 

Создание поверхности с сеткой конечных элементов  

Для создания поверхности SMARTEAM сеткой конечных элемен-
тов необходимо выполнить следующие действия: 

1. В главном меню указать кнопку Elements (рис. 14). 
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Рис. 14 Панель инструментов MSC.Patran 

Откроется окно, в котором требуется задать свойства конечных 
элементов сетки (рис. 15). 

2. В верхней части появившейся панели выбрать Action > 
Create, Object > Mesh, Type > Surface. 

3. Настроить или проверить установку кнопок Element Shape 
(форма элемента) > Quad, Mesher (тип генератора сетки)> 
IsoMesh, Topology > выбрать элемент. 

4. Предварительно щёлкнув в окне Surface List (список 
поверхностей) указать мышью на экране последовательно 
разбиваемые поверхности. В окне должна появиться надпись 
со списком выбранных поверхностей. 

5. Ввести в окне Value (величина) – длина ребра элемента. 
Снять маркер параметра Automatic Calculation 
(автоматическое вычисление) и нажать Apply. 

6. Поскольку конечные элементы не соединены вдоль 
геометрических границ, то необходимо «сшить» их вместе. 
Для этого на верхней части панели Finite Element выбрать 
Action > Equivalence, Object > All, Method > Tolerance 
Cube (область допусков представляется кубом с ребром 
0,005 м). В пределах этой области все узлы будут 
объединяться в один. Нажать кнопку Apply. в строке 
сообщений внизу экрана будет указано сколько узлов было 
объединено. 
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Рис. 15. Панель свойств элементов сетки 
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Создание материала 

Для того чтобы создать материал в MSC.Patran необходимо выпол-
нить следующие действия: 

1. В главном меню, нажать кнопку Materials (рис. 14). В появив-
шейся панели выбрать Action > Create, Object > Isotropic, 
Method > Manual Input (ручной ввод параметров материала). 

2. В окне Material необходимо указать название материала. 
3. Нажать кнопку Input Properties (ввод свойств). 
4. Появится панель Input Options и в этой панели в строку Elastic 

Modulus ввести значение модуля упругости в Н/м2; в строку 
Poisson Ratio (коэффициент Пуассона) (рис. 16). Остальные 
строки можно не заполнять, так как они заполняются при 
решении динамических задач. 

 
Рис. 16. Задание свойств материала 
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5. Нажать Ok, чтобы закрыть панель и Apply на панели Materials. 
При этом свойства материала только выбраны, но не назначены 
на конечные элементы. 

Задание физических Свойств 

1. В главном меню нажать кнопку Properties (рис. 14). 
2. В появившейся панели Element Properties указать Action, Type. 
3. В окно Properties Set Name (имя варианта свойств) ввести имя 

свойства. 
4. Нажать на кнопку Input Properties. 
5. На появившейся панели Input Properties, щёлкнуть мышкой в 

окне Material Name и выбрать материал заданный ранее в списке 
Material Properties Set. 

6. Ввести в окно Thickness панели Input Properties величину 
толщины материала. 

7. На панели Element Properties поместить курсор в окно Select 
Members (Выбрать элементы) и затем курсором выбрать все 
поверхности на экране. 

8. Нажать кнопку Add (придать свойства), в окне Application Region 
должна повториться запись со списком выделенных поверхностей. 
После этого необходимо нажать кнопку Apply. При этом заданные 
свойства будут назначены указанным конечным элементам. 
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Рис. 17. Окно назначения материала 

Моделирование нагрузок и граничных условий 

Задание распределённых нагрузок. 
1. В главном меню нажать кнопку Loads/BCs. 
2. В появившейся панели Loads/Boundary Conditions выбрать 

Action>Create, Object>Distributed Load (распределённая 
нагрузка), Type>Element Uniform (равномерная по элементу) 
(рис. 18). 

3. В окно New Set Name ввести имя. 
4. Нажать кнопку Input Data (ввести данные). 
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5. В появившейся панели Input Data в окно Edge Distributed Load 
(нагрузка, распределённая по ребру) ввести, например: < , , –200>, 
что означает – нагрузка задана против положительного 
направления оси z . Пробелы по направлениям осей x и y означают 
отсутствие нагрузок. Окно Edge Distributed Moment необходимо 
оставить пустым, т.е. нагрузка от моментов отсутствует. Нажать 
Ok. 

6. В панели Loads/BC нажать кнопку Select Application Region 
(выбрать область приложения нагрузок), в появившейся панели с 
этим же названием под разделом Geometry Filter (геометрический 
фильтр) указать Geometry. Это означает, что нагрузки будут 
задаваться на геометрическом образе модели, а не на конечно-
элементном. 
Задавать нагрузки и граничные условия удобнее на геометрическом 

образе, т.к. конечных элементов на одном геометрическом элементе мо-
жет быть очень много и задавать нагрузку на каждый элемент трудоём-
ко. MSC.Patran перед расчётом автоматически перенесёт все нагрузки и 
граничные условия на соответствующие конечные элементы. 

7. В этой же панели поместить курсор в окно Select Surface Edge 
(выбрать ребро поверхности). Используя указатель мыши, выбрать 
четыре ребра средних поверхностей, затем нажать Add. Номера 
выбранных рёбер поверхностей должны появиться в окне 
Application Region. Нажать Ok. 

8. Нажать кнопку Apply на панели Loads/BC. На экране должны 
появиться символы, обозначающие нагрузку (стрелки) и её 
величину (цифры возле стрелок). 
В качестве граничного условия в задаче будет выступать 

Displacement (ограничение перемещений). Для задания граничных ус-
ловий необходимо выполнить следующие действия: 

1. В главном меню нажать кнопку Loads/BCs. 
2. В появившейся панели выбрать Action > Create, Object > Dis-

placement, Type > Nodal (узлы) (рис. 18). 
3. В окно New Select Name ввести имя граничных условий pinned. 
4. Нажать Input Data (ввести данные). 
5. В появившейся панели в окно Translations (перемещения) вве-

сти <0, 0, 0>, что означает запрет перемещений по осям x , y , z . Окно 
Rotations необходимо оставить пустым. Нажать Ok. 

6. Нажать кнопку Selection Application Region в панели 
Loads/BCs, после этого появится панель с таким же именем, в которой 
необходимо указать Geometry в разделе Geometry Filter. 
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7. Поскольку в геометрической модели присутствую различные 
геометрические сущности (Entities): рёбра, поверхности, вершины, то 
необходимо точно указать какие сущности будут ограничены по пере-
мещениям. Для этого в Select Menu (меню выбора) нажать кнопку Edge 
Option. 

Это означает, что на экране курсором мыши будут выделяться 
только Edges (рёбра) геометрической модели. 

8. Поместить в окно Select Geometric Entities курсор, и используя 
указатель мыши выбрать на экране четыре ребра на внешних поверхно-
стях пластины. При выборе необходимо удерживать нажатой клавишу 
Shift, чтобы происходило суммирование выбора. Затем нажать Add и в 
окне Application Region должны появиться номера выбранных рёбер. 
Нажать Ok. 

9. На панели Loads/BCs нажать Apply. С помощью кнопок про-
смотра изображений можно подобрать вид изображения для просмотра 
нагрузок и граничных условий. Граничные условия изображаются ус-
ловными символами, около которых указываются номера ограниченных 
степеней свободы: 1, 2, 3, это означает, что ограничены перемещения по 
осям x , y , z . Вращательные степени 4, 5, 6 не указаны – значит, ограни-
чений нет. 

Создание входного файла для MSC.Nastran 

Для каждой расчётной программы, которые могут быть использо-
ваны вместе с MSC.Patran (их тип задаётся в Preference), создаются свои 
входные файлы. В данном случае рассмотрим создание файла для про-
граммы MSC.Nastran. 

1. В главном меню нажать кнопку Analysis. 
2. На появившейся панели выбрать Action > Analyze, Object > En-

tire Model, Method > Analysis Deck (метод брать с рабочего стола или 
панели управления) (рис. 19). 

3. Нажать кнопку Solution Type (тип задачи). 
4. В появившейся панели выбрать Linear Static (линейный стати-

ческий расчёт), нажать Ok. 
5. Нажать на кнопку Translation Parameters. В появившейся па-

нели в разделе Data Output (вывод данных) нажать кнопку XDB and 
Print и в появившемся меню выбрать XDB Only (для сокращения разме-
ров файла результата). Нажать Ok. 
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Рис. 18. Окна задания нагрузок и граничных условий 
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6. Нажать кнопку Apply, чтобы запустить MSC.Nastran. На экране 
появляется окно MSC.Nastran с указанием размеров оперативной и дис-
ковой памяти, занятой под задачу, а также сообщение, что MSC.Nastran 
запущен, время и число. Через некоторое время, после окончания расчё-
та, окно пропадает. В строке сообщений можно прочитать сообщение о 
том, что трансляция входного файла была завершена успешно. 

 

Рис. 19. Окно задания типа расчета 
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Передача в среду MSC.Patran результата решения 
задачи для обработки постпроцессором 

1. В главном меню нажать кнопку Analysis. 
2. На появившейся панели выбрать Action > Attach XDB, Object > 

Result Entities, Method > Local (рис. 20). 
3. Нажать на кнопку Select Results File. 
4. Нажать Apply на панели Analysis. 

 
Рис. 20. Окно передачи результатов в среду MSC.Patran  
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Обработка результата постпроцессором 

Создание Fringe-изображения и деформированного изображения 
(Deformation Plot) 

1. В главном меню нажать кнопку Results. 
2. На появившейся панели выбрать Action > Create, Object > 

Quick Plot (быстрое изображение). 
3. В окне Select Result Cases панели Results выбрать Default, 

Static SubCase, в окне Select Fringe Result выбрать Displacement, 
Translational. 

4. В окне Select Deformation Result панели Results выбрать Dis-
placement, Translational . 

5. Нажать кнопку Apply. На экране появится изображение панели 
с цветной шкалой уровней SMARTEAM указанием максимальных и ми-
нимальных величин перемещений (рис. 21). 

 
Рис. 21. Окно результатов расчета 
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6. Для того, чтобы не мешало графическое изображение геометри-
ческой модели, необходимо убрать с экрана графику, нажав кнопку с 
изображением метлы (Reset Graphics), после этого нажать Apply на па-
нели Results. 

7. Можно просмотреть форму деформации, воспроизведя «ожив-
ление» модели. Для этого нужно в окне Animate поставить скобку и на-
жать 
Apply. Появляется окно, в котором указаны параметры анимации (ско-
рость анимации). Передвигая движок можно регулировать скорость 
анимации. 

 

Самостоятельная работа «Построение виртуальных 
моделей станков с ЧПУ» 

Введение 

Сегодня на предприятиях приборо- и машиностроения наблюдается 
постоянное усложнение выпускаемой продукции. Усложняется и метал-
лообрабатывающее оборудование, станки приобретают все большую 
универсальность, стойки ЧПУ оснащаются новыми функциями и вместе 
с тем усложняется и технология обработки на этом оборудовании.  

Цена ошибки на современном производстве возрастает многократ-
но, грозя порчей заготовок, выходом из строя инструмента и узлов стан-
ка, длительным простоем оборудования.  

В связи с чем, при подготовке производства изделий на станках с 
ЧПУ необходимо использовать программные системы, основная задача 
которых - симулировать процессы, происходящие с оборудованием, ин-
струментом, заготовкой. Вместе с тем, всё большую роль в успешности 
предприятия продолжает играть фактор времени, который выражается 
не только в сокращение сроков разработки изделия, но и в постоянном 
сокращении его времени жизни. Необходимо учитывать, также, и посто-
янно растущее влияние информационных технологий в технической 
подготовке производства, постоянно растущее значение кооперации 
предприятий и тенденции в области развития виртуальных предприятий. 
Это определенно внесет изменения в существующую методику разра-
ботки технологии производства изделий.  

В такой ситуации единственно возможным путем обеспечения вы-
соких темпов, гибкости и качества производства, является использова-
ние "виртуальных производственных комплексов". С помощью этих 
программных систем становится возможным осуществлять верифика-
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цию и оптимизацию управляющих программ для любых типов станков с 
ЧПУ, осуществлять контроль состояния инструмента и заготовки, повы-
сить эффективность использования парка машин. 

Система Vericut 

Предприятия, желающие уменьшить затраты и увеличить эффек-
тивность производства зачастую вкладывают немалые средства в покуп-
ку современного оборудования с ЧПУ. Однако, опыт показывает – бес-
полезно односторонне развивать средства производства (оборудование), 
необходимо также постоянно развивать программное обеспечение, ис-
пользуемое в технологическом бюро. Имеется множество примеров, ко-
гда ничтожно малое время, потраченное на проверку управляющей про-
граммы до ее передачи в цех, может сберечь дорогостоящее оборудова-
ние, оснастку и инструмент. Одним из инструментов, разработанных 
специально для этой цели, является программное обеспечение проверки 
управляющий программ (УП) (верификаторы управляющих программ). 

Многие из заводов теперь полагаются на программное обеспечение 
верификации для того, чтобы проверить собственные УП. Программное 
обеспечение может гарантировать, что первая полученная деталь будет 
правильной, таким образом, пробные прогоны УП на деревяшках или 
алюминии станут вещью из прошлого. 

Кроме того, определенную выгоду приносит способность верифи-
каторов УП оптимизировать скорости подачи. Время производственного 
цикла, качество детали и ресурс инструмента могут улучшаться в ре-
зультате более совершенного контроля над режимами обработки. Такая 
УП с оптимизированными параметрами обработки становится проще с 
точки зрения ее последующего контроля оператором станка.  

На сегодняшний день одним из основных верификаторов УП явля-
ется VERICUT. Это признанная во всем мире система, ее используют 
ведущие предприятия Европы, Америки, России среди них: Airbus, Volvo 
Aero Norway, Dassault Aviation, Cosworth Racing, Prost Grand Prix, Renishaw, 
Siemens, Mazak, Sandvik, BMW Group…. Как видно, эта система пред-
ставлена в различных сферах от производства инструмента, до автомо-
бильной, авиа и аэрокосмической промышленности. 

Vericut стоит на трех основных китах: 
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VERICUT 

Верификация Оптимизация Имитация 

Верификация (Verification) 

Верификация обеспечивает реалистичную имитацию и контроль 
УП для фрезерной, токарной, эрозионной и др. видов обработки, а также 
обнаружение таких ошибок, как неправильное построение траектории 
инструмента, недостаточная точность обработки, врезание на ускорен-
ной подаче, столкновения инструмента или державки, столкновения с 
зажимным приспособлением и оснасткой, ошибки постпроцессора. 

В любое время можно изменять вид и масштаб модели, выполнять 
сечения, устанавливать полупрозрачный режим. Можно измерять тол-
щину стенок, объем, расстояния, углы и др. 

Верификация управляющих программ выполняется для широкого 
спектра систем ЧПУ. При этом поддерживаются команды коррекции ин-
струмента, сверлильные циклы, подпрограммы и т. д. Имеются средства 
для создания и редактирования описаний систем ЧПУ, а также для кон-
вертирования УП. 

Инструменты верификации предоставляют программисту средства 
для проверки траектории движения инструмента в УП на электронной 
модели станка до ее отправки в цех. Такой метод практически полно-
стью исключает как возможность аварийного отказа станка, так и дли-
тельную доводку УП на станке.  

Необходимо отметить, что верификация в Vericut, в отличие от 
встроенных модулей верификации CAD/CAM систем, ведется в кодах 
станка, т.е. идет проверка G-кода которых поступает на станок. 
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Оптимизация (OptiPath) 

В случае использования опций оптимизации, программное обеспе-
чение читает файл траектории движения инструмента (УП) и автомати-
чески изменяет назначенные скорости подачи так, чтобы подобрать наи-
более оптимальную подачу в зависимости от условий обработки и пара-
метров режущего инструмента. Индивидуальный подбор режимов реза-
ния повышает эффективность процесса обработки и уменьшает время 
изготовления детали без потери качества. Оптимизация может приме-
няться для черновой, получистовой, чистовой и высокоскоростной обра-
ботки. При оптимизации используется встроенная база знаний и матема-
тический аппарат. 

При оптимизации Vericut читает файл траектории движения инст-
румента (G-код) и разбивает движение на ряд меньших фрагментов. Зная 
количество материала удаленного в каждом фрагменте, Vericut назнача-
ет лучшую скорость подачи для данного фрагмента траектории (рис. 22). 
Таким образом, в кадрах УП меняются только значения под адресом F 
(скорость подачи). 

В процессе оптимизации учитывается: мощность и тип шпинделя; 
величина ускоренной подачи; жесткость фиксатора детали; характери-
стики фрезы, включая материал, длину и число зубьев. 

Реалистичная имитация работы станка (Machine 
Simulation) 

При многокоординатной обработке совместная работа линейных и 
поворотных исполнительных органов станка может привести к столкно-
вениям и поломке инструмента, приспособлений или узлов станка. Реа-
листичная имитация работы станка, с контролем столкновений, помога-
ет избежать таких ситуаций. Система контролирует столкновения инст-
румента, державки, шпинделя, зажимного приспособления, заготовки, 
исполнительных органов и узлов станка. 
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= область контакта 

= область контакта 

Рис. 22: верхний рисунок – траектория и скорость подачи,  установлен-
ные CAM системой; нижний рисунок – оптимизированные в Vericut 

траектория и скорость подачи 

Имеющаяся в системе библиотека станков содержит широкий 
спектр моделей многокоординатного оборудования. Можно создавать 
собственные описания станков или редактировать имеющиеся. 

Наибольший эффект применения Vericut дает для 4- и 5-
координатных станков, так как при многокоординатных перемещениях 
наиболее вероятны не контролируемые CAM-пакетом столкновения ин-
струмента с заготовкой, приспособлением, узлами станка. Кроме того, 
проверяя правильность УП, Vericut одновременно проверяет правиль-
ность работы постпроцессора. 
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Общая структура системы Vericut 

Общая структура Vericut представлена на рис. 23, кратко об основ-
ных составляющих в таблице 1. 

 

Рис. 23. Общая структура Vericut 

Таблица 1: основные компоненты Vericut 

Model 
Export   

Экспорт модели обработанной заготовки в форматах 
STL и IGES. 

Multi-Axis Симуляция и верификация 4-х и 5-ти координатной 
фрезерной, сверлильной, токарной обработки и сме-
шанной токарно-фрезеной обработки.  

CNC 
Machine 
Probing

Создание измерительных циклов на любом этапе 
процесса обработки. Снижает вероятность ошибки 
благодаря симуляции измерительных операций.  

Inspection 
Sequence 
 

Позволяет сохранять проект «в процессе» (in-
process), чтобы не отрабатывать уже оптимизирован-
ные кадры управляющей программы.  

EDM Die 
Sinking

Точное моделирование и контроль работы прошив-
ных электроэрозионных станков. Определение заре-
зов, пережога или недожога, объема удаленного ма-
териала, областей контакта и перекрытия электрода 
(включая составные электроды). 

AUTO-
DIFF

анализ различия между конструкторской моделью и 
обработанной заготовкой в Vericut. 
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Cutter / 
Grinder 
Verification 

Контроль обработки на многокоординатных режуще-
шлифовальных станках. Элементы упрощенного ин-
терфейса специально для шлифовальных станков. 

Cutter / 
Grinder 
Machine 
Simulation 

Моделирование обработки на режуще-
шлифовальных станках и проверка на предмет столк-
новений деталей и механизмов станка. 

CAD/CAM 
Interfaces  

Для систем подобных Vericut, принципиальную роль 
играет наличие интерфейсов передачи данных с 
CAD/CAM системами.  
Vericut имеет прямые интерфейсы со следующими 
системами: CATIA V4/V5, Unigraphics, Pro/E, 
hyperMILL  и др. 
Наличие прямого интерфейса позволяет передавать 
данные (электронные модели станков, заготовок, де-
талей и др.) из CAD/CAM системы в Vericut без ис-
пользования нейтральных форматов STL и IGES. При 
обратной передаче – из Vericut в CAD/CAM систему 
данные передаются в «родных» форматах CAD/CAM 
системы, а также существуе возможность передать в 
CAD/CAM систему модель заготовки в процессе об-
работки (Inproces) для проектирования онастки, ана-
лиза и пр. 

Mold & Die 
 

Проверка, анализ, оптимизация траекторий фрезер-
ной трехкоординатной обработки, обработки отвер-
стий и электроэрозионной обработки. Проверка на 
предмет зарезов, а также столкновений заготовки и 
крепежной оснастки с режущими и нережущими час-
тями инструмента 

 

 42

http://www.cgtech.com/usa/mold-die/


Начало работы 

Интерфейс Vericut 

Vericut имеет доступный интерфейс (рис. 24). В рабочем окне ото-
бражается модель заготовки и модель станка с заготовкой как вместе так 
и по отдельности, ниже движок управления скоростью симуляции и ок-
но сообщений. В левой части окна отображается дерево проекта, в верх-
ней части экрана расположены иконки управления проектом (рис. 25). 

В дереве проекта: Project – имя пректа, Setup – установ, Control – 
вид стойки ЧПУ, Machine – имя станка из каталога, во вкладке Attach 
находятся модели приспособлений, заготовки и модель детали. 

  

Рис. 24. общий вид интерфейса Vericutрис 4: дерево проекта 

В Vericut также существует дерево компонентов (Component tree) 
(рис. 25) в котором отображена кинематика станка и модели исполни-
тельных механизмов. 
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Новый проект 

 

Рис 25: Дерево компонентов, где: B,C – поворотные оси; X,Y,Z – оси пе-
ремещений компонентов станка; во вкладках Models – находятся соот-

ветствующие модели подвижных и статичных узлов станка 
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VERICUT может симулировать в одной сессии множество устано-
вок, используемых для создания детали. Файл проекта может содержать 
одну или несколько установок. Множественные установки могут иметь 
несколько NC операций, выполняемых на одном станке с деталью, пе-
ремещаемой для каждой операции. NC операции могут быть на разных 
станках с разными оснастками, инструментами и настройками. Каждая 
установка ссылается на свой собственный станок, систему управления, 
инструменты, NC программы, оснастки, настройки симулирования и т.д. 

Установка может быть создана из эскиза, импортирована из другого 
файла проекта или из старой версии пользовательского файла. 

Новый проект начинается с задания кинематики будущего станка. 
Vericut будет отрабатывать УП даже если не заданы модели узлов стан-
ка, но в этом случае он не будет отслеживать столкновения между узла-
ми станка. 

На рисунке 26 показана схема пяти координатного станка с ЧПУ, 
показана система координат станка (оси XwYwZw), оси движения (X, Y, 
Z), оси вращения (A, B) и основные компоненты, файлы управляющий 
программ обрабатывает система управления Fanuc 12M CNC. 

 

Рис. 26: схема пяти координатного станка Cincinnati T30 
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Новый файл проекта File > New Project, при помощи иконки 

Working Directory  задается рабочая директория проекта, в которой 
находятся файлы проекта. Далее отображается система координат ком-
поненты и модели Machine/Cut Stock в виде: кликнуть правой кнопкой 
мыши в рабочем окне VERICUT > Display Axes > Component, Model; 
кликнуть правой кнопкой мыши в рабочем окне VERICUT > View Type= 
Machine/Cut Stock.  

Далее загружается система управления либо из рабочей директо-
рии, либо из имеющейся библиотеки: Configuration > Control > Open, 
Shortcut=Library. После этого действия в дереве проекта (Project Tree) 
во вкладке Project > Setup1 > СNС Machine > Control появляется имя 
системы управления. 

Далее определяются компоненты на стороне инструмента станка с 
"Base" в "Tool" –  Base > X > Y > A > Spindle > Tool, на этом же шаге 
будет задан цвет для моделей узлов станка. Отобразим дерево компо-
нентов (Component tree) для этого в главном меню выбрать 
Configuration > Component Tree. Установим цвет для компонента 
"Base", для этого в дереве компонентов правой кнопкой мыши выбираем 

вкладку Base (0,0,0), нажмите правую кнопку мыши и выберите  

Component Attributes, в открывшемся окне Modelling (рис. 27) на 
вкладке Component Attributes, указать цвет (color) и выбрать Apply. 
Окно Modeling оставьте открытым для установки цветов компонентов, 
которые будут добавлены позже. 

Далее добавляются оси перемещений станка (X, Y, A), компонент 
«шпиндель» (spindle) и инструмент (tool). Чтобы добавить ось X в Base, 

правой кнопкой мыши выберите в Component Tree Base (0,0,0) и 
выберите Append > X Linear, в окне Modeling укажите цвет (Color), 
нажмите Apply. Таким же образом вводятся оси  "Y" в "X" и "A" в "Y". 
В случае с осью вращения A, в меню Append необходимо выбрать A Ro-
tary. 

Добавление шпинделя к оси вращения А. Правой кнопкой мыши 

выберите в Component Tree A (0,0,0) и выберите Append > Spindle 
, в окне Modeling перейдите на вкладку Position и в графе Position (рис. 
28) укажите смещение 0 0 -12.5, укажите цвет. 
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Рис. 27: вид вкладки Components Attributs окна Modelling 

Добавление «Tool» в «Spindle». Правой кнопкой мыши выберите в 

Component Tree Spindle (0,0,-12.5) и выберите Append > Tool, в 
окне Modeling установите Color=White, Apply.  

Компонент Tool определяет, откуда будут загружены токарные ин-
струменты. Компонент Tool должен быть определен перед обработкой 
файла траектории движения инструмента (УП). Ноль инструмента 
обычно размещается на пересечении оси инструмента с плоскостью 
шпинделя. 
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Рис. 28. Вид вкладки Position окна Modeling 

Следующие шаги определяют компоненты с "Base" в "Stock" – 
компоненты на стороне заготовки станка: Base > Z > B >Attach > Fix-
ture > Stock > Design. Оси Z Linear и B Rotary добавляются аналогично 
осям X и A. Для добавления Fixture > Stock > Design к оси B, нужно 
вырезать (Cut) компонент Attach из Base и добавить его к оси B, для че-
го нужно правой кнопкой мыши выбрать Attach (0,0,0) в дереве ком-

понентов, выбрать Cut, затем правой кнопкой мыши выбрать 

B (0,0,0) и выбрать Paste. 
В конце всех преобразований, дерево компонентов (Components 

tree) должно принять следующий вид (рис. 29). 
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Рис. 29. дерево компонентов до и после добавления кинематики станка 

Ноль компоненты Fixture это место, откуда будут загружаться мо-
дели оснастки. Наличие оснастки в станке не оказывает влияния на то, 
как будет обработан файл траектории движения инструмента (УП), од-
нако, это необходимо для обнаружения столкновений между оснасткой 
и другими компонентами станка. 

Ноль компоненты Stock это место, в которое будет помещена заго-
товка. Этот тип компонента должен быть определен в каждом станке. 
Компонент Stock обычно привязан к компоненту Fixture, но в общем 
случае компонент Stock может быть привязан к любому другому компо-
ненту. Единственное условие – компонент должен быть определен перед 
обработкой файла траектории движения инструмента (УП). 

Сохраните проект в рабочей директории, как файл станка: в дереве 
компонентов (Components tree) File > Save As Machine. 

Следующим шагом нужно задать модели элементов для составлен-
ной кинематики, для того, что бы Vericut мог отслеживать столкновения 
и опасные сближения между всеми элементами системы «элементы 
станка – приспособление – инструмент – заготовка».  

Модель станка в Vericut может быть построена с любой степенью 
детализации. Для определения формы узлов станка, заготовки и техно-
логической оснастки и Vericut организованы простейшие функции мо-
делирования: построение цилиндров, конусов, блоков, профильных тел 
вращения. Элементы более сложной формы импортируются из CAD-
пакетов в формате STL или IGES. Для точного позиционирования эле-
ментов модели друг относительно друга в системе имеются средства их 

 49



переноса. Однако при создании элементов модели станка в CAD–пакете 
целесообразно вести их построение относительно одной системы коор-
динат, как правило, относительно «нуля» станка. В этом случае при пе-
редаче элементов моделей через CAD–интерфейс Vericut или при помо-
щи форматов STL или IGES, элементы модели буду правильно позицио-
нироваться в Vericut. 

Теперь наполним проект моделями элементов станка. Добавим 
"Base" модель, в  Component Tree  правой кнопкой мыши выберите 

Base (0,0,0),  выберите  Component Attributes, вкладка Model 
(рис. 30), Type=Model File, в строке Model File указать путь к директо-
рии в которой находится модель; задать цвет подели; Add. 

 

Рис. 30. Вид вкладки Model окна Modeling 

Таким образом, добавляются все остальные модели. Если модель 
добавляется к компоненту, которому было присвоено смещение, то и 
модели нужно присвоить такое же смещение! 

При размещении станка в «нуле», компоненты "Y" и "Z" попадают 
в состояние столкновения (рис. 31). Так как станки VERICUT сконст-
руированы так, что все компоненты размещаются в соответствующих им 
нулях, столкновения во время определения станка будут общими. 

Следующий шаг – определение таблицы начальных положений ор-
ганов станка (Initial Machine Location table) для перемещения станка из 
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состояния столкновения в начальную позицию. Таблицы размещения 
станка описывают, как будет позиционирован станок первоначально, как 
станок двигается при смене инструментов и шпинделей, а также разме-
щение референтной точки станка. 

 

Рис. 31. Все компоненты станка находятся в соответствующих им ну-
ля. 

Для задания Initial Machine Location table в главном меню Con-
figuration > Machine Settings > вкладка Tables, выбрать Add/Modify, в 
строке Table Name указать Initial Machine Location,в строке Values ука-
зать значения 0 60 62, Add (рис. 32). 
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Рис. 32. Определение таблицы начальных положений органов станка. 

После проделанных манипуляций в окне Add/Modify Machine Table, 
в окне Machine Settings появится строка Initial Machine Location со зна-
чениями смещения > OK.. После введенных изменений необходимо сде-

лать сброс станка нажатием на иконку «Reset Model» , после чего 
модель станка должна приять начальное положение X0 Y60 Z62 A0 B0 
(рис. 33). 

Пересохраните проект. 
Последний шаг в разработке проекта – добавление моделей заго-

товки и оснастки. Отобразите Project Tree нажатием на иконку . В 
Project Tree кликните правой кнопкой мыши на Setup 1 и выберите 

Expand All Children, в Project Tree дважды кликните на Fixture, 
появится окно Modeling в нем выбрать вкладку Model (рис. 30) и ука-

зать путь к файлу модели. Таким же образом в ветку Stock (0,0,0) 
дерева проекта (Project tree) добавляется модель заготовки (рис. 34). 

В Project tree кликните правой кнопкой мыши на  Tooling и 

выберите  Open … и укажите путь путь к библиотеке инструмента. 
Последний шаг – добавление УП. В Project Tree кликните правой 

кнопкой мыши на NC Programs, выберите Add/Modify NC Pro-
grams…, в окне ТС Program выберите Add и укажите путь к УП. 
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Рис. 33. Правильное расположение модели собираемого станка. 

 

Рис. 34. Вид собранной модели станка с заготовкой и оснасткой 

 53



После введенных изменений необходимо сделать сброс станка на-

жатием на иконку «Reset Model»  и произвести симуляцию Play to 

End  

Содержание отчёта 

Результатом проделанной работы студента, является законченный 
проект виртуальной модели станка. 

Отчет должен содержать в себе: 
• Исходные данные; 
• Изображение кинематической схемы в виде дерева проекта 

Vericut 
• Описание этапов построения 
• Изображение собранного станка 

Самостоятельная работа «Разработка постпроцессо-
ров для станков с ЧПУ» 

Введение 

Разработка постпроцессоров является традиционной задачей – еще 
до появления CAD/CAM-систем постпроцессоры входили в состав САП 
(Систем Автоматизации Программирования), выполнявших роль 
средств автоматизации разработки управляющих программ для станков 
с ЧПУ. Геометрия обрабатываемой детали и технология обработки опи-
сывались в САП в текстовой форме (например, на языке АРТ), после че-
го выполнялся расчет траектории движения инструмента. Для результи-
рующего описания траектории обычно использовался стандартный фор-
мат CLDATA (Cutter Locations DATA). Эти данные обрабатывались 
постпроцессором, который формировал управляющую программу (УП) 
для конкретной модели станка с ЧПУ. 

Язык APT 

Имя языка программирования АПТ (APT) происходит от начальных 
букв полного названия “Automatically Programmed Tools”, что в переводе 
означает “Автоматические программируемые инструменты”. 

АПТ - первый язык программирования для применения в специали-
зированной области, первый язык программирования операций обработ-
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ки деталей на станках с числовым программным управлением (ЧПУ). Он 
разрабатывался в Массачусетском технологическом институте (МТИ) по 
контракту с ВВС США. Группу разработчиков  в 1956 году возглавлял 
математик Дуглас Т. Росс. 

АПТ это не только язык станков с ЧПУ, но также и программа, ко-
торая выполняет расчеты по определению положений режущего инст-
румента в соответствии с операторами языка. Система АПТ предназна-
чена для программирования операций в трех мерном пространстве, при-
чем ее можно использовать для управления станками, которые имеют до 
пяти управляемых осей. Ее можно использовать для управления процес-
сами разнообразных операций механической обработки. 

Язык включает четыре типа операторов: геометрические операторы, 
операторы движения, операторы постпроцессора и вспомогательные 
операторы. 

Геометрические операторы (их часто называют операторами опре-
деления) определяют геометрические элементы, которые составляют де-
таль. 

Операторы движения применяются для описания траектории пере-
мещения режущего инструмента. 

Операторы постпроцессора используются применительно к кон-
кретному станку и его системе управления для задания скорости подачи 
и резания и для учета других характеристик данного станка. 

Вспомогательные операторы представляют собой различные ко-
манды, применяемые для определения типа деталей, инструментов, до-
пусков и т. п. 

Мощным средством языка АПТ является возможность использова-
ния макрооператоров (макросов). Они применяются в тех случаях, когда 
определенная последовательность движений повторяется многократно в 
процессе выполнения конкретной программы. Цель использования мак-
рооператоров заключается в уменьшении числа операторов в записи 
всей АПТ-программы.  

В 70-е и 80-е годы появились новые подходы к составлению управ-
ляющих программ для обработки деталей на станках с ЧПУ: применение 
в процессе программирования интерактивной машинной графики. 

При использовании интерактивной машинной графики процедура 
программирования реализуется на графическом терминале, оснащенном 
CAD/CAM или CAM системами. Используя геометрические данные, оп-
ределяющие деталь в процессе автоматизированного проектирования 
технолог-программист формирует траекторию движения инструмента. 

Выходными данными такой процедуры программирования является 
текст АПТ-программы, т. е. фактически массив положений режущего 
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инструмента (Cutter Locations DATA, CLDATA), который затем пропус-
кается через постпроцессор, с целью получения программы в кодах 
станка (G- код). 

Средства автоматизации разработки постпроцессо-
ров. Система IMSpost 

Самым важным результатом работы CAM-систем является управ-
ляющая программа (УП) содержащая траекторию движения инструмен-
та при обработке. Однако эту программу нельзя напрямую использовать 
на станке, так как каждый тип станков имеет уникальную кинематиче-
скую схему и предъявляет различные требования - например, может 
производить обработку с различным количеством одновременно управ-
ляемых осей, и т.д. Кроме того, конкретный станок управляется опреде-
ленной системой ЧПУ, именно она принимает на входе файл траектории 
инструмента и напрямую руководит перемещениями инструмента и дру-
гими действиями станка. 

Но не только каждый тип станков имеет свои уникальные характе-
ристики. Программное обеспечение системы ЧПУ также обладают раз-
личными особенностями, поэтому перед выводом на станок траектория 
инструмента в обязательном порядке должна быть отформатирована под 
конкретную комбинацию «станок - система ЧПУ», т.е. обработана пост-
процессором. 

С точки зрения переработки информации постпроцессор можно 
считать специализированным транслятором, осуществляющим перевод с 
языка CLDATA  на язык управляющей программы (G -код). Информа-
ция о траектории движения инструмента, содержащаяся в записях 
CLDATA, перерабатывается постпроцессором в команды, управляющие 
перемещением исполнительных органов станка.  

Таким образом, постпроцессор – программа, транслирующая вхо-
дящий CLDATA/APT файл, в файл управляющей программы в кодах 
используемой системы ЧПУ и с учетом особенностей самого оборудо-
вания. 

Выполняемые постпроцессором функции весьма разнообразны и 
выходят за пределы простого транслирования. Типовыми функциями 
постпроцессора являются: 

• считывание данных, подготовленных процессором; 
• перевод координат траектории движения инструмента в систе-

му координат станка; 
• проверка по пределам перемещений исполнительных органов 

станка; 
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• линеарилизация траектории движения инструмента с учетом 
кинематической схемы станка; 

• назначение подачи с учетом ограничений, связанных с характе-
ром движения, допустимым диапазоном подач; 

• формирование и выдача в кадр дополнительных функций; 
• формирование команд на перемещение с учетом значения еди-

ницы дискретности (цены деления) УЧПУ; 
• кодирование и вывод в кадр значений подач и скоростей шпин-

деля; 
• вывод команд на включение охлаждения, команд зажимов – 

разжимов; 
• формирование команд обеспечивающих цикл смены инстру-

мента; 
• формирование команд коррекции длинны и радиуса инстру-

мента; 
• синтаксический контроль правильности задания операторов 

управления постпроцессором и др. 
Казалось, что развитие систем ЧПУ приведет к такой унификации 

форматов УП, что сделает постпроцессоры ненужными. Однако, по ряду 
причин этого не произошло. Основная из них – стремление изготовите-
лей оборудования с ЧПУ обеспечить пользователя собственными сред-
ствами автоматизации “ручного” программирования, реализованными в 
системе ЧПУ. Унификация формата УП осталась на уровне стандарта 
ISO, который носит достаточно общий характер и не снимает необходи-
мости в разработке постпроцессоров. Таким образом, и сегодня пост-
процессоры входят в виде модулей в состав CAD/CAM-систем (или 
САМ-систем, далее мы не будем делать различий). 

Потребность в разработке большого числа постпроцессоров и зна-
чительная трудоемкость их разработки привели к появлению средств ав-
томатизации проектирования постпроцессоров. Эти средства прошли 
свой путь развития – от библиотек стандартных подпрограмм до специ-
альных автоматизированных систем (генераторов построцессоров). 

Сегодня практически любая CAD/CAM-система имеет в своем со-
ставе собственные генераторы для автоматизации разработки постпро-
цессоров. Эти генераторы используют во многом общие идеи, но отли-
чаются “глубиной” их реализации. Проблема состоит в том, что для раз-
работчиков CAD/CAM-систем автоматизация проектирования постпро-
цессоров является второстепенной задачей, и основные усилия разра-
ботчиков направлены на решение других задач, в большей степени 
влияющих на положение их продукта на рынке. 
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Данная ситуация привела к появлению на рынке фирм, специализи-
рующихся на разработке таких генераторов постпроцессоров, которые 
могли бы встраиваться в CAD/CAM-системы или использоваться в каче-
стве автономных средств автоматизации. Понятно, что уровень автома-
тизации проектирования постпроцессоров, обеспечиваемый этими гене-
раторами, должен быть существенно выше чем тот, который предлагает-
ся разработчиками CAD/CAM.  

Наиболее известной из таких фирм является компания IMS 
Software, Inc. (США), выпустившая на рынок универсальный генератор 
постпроцессоров IMSpost. Можно сказать, что эта разработка наиболее 
полно реализует современные идеи в области проектирования постпро-
цессоров, а именно: 

• действия постпроцессора по преобразованию траектории инст-
румента в управляющую программу описываются на специаль-
ном языке высокого уровня, в котором имеется возможность 
оперировать параметрами траектории инструмента и управ-
ляющей программы, как понятиями языка. Этим достигается 
максимальная гибкость проектирования при одновременной 
простоте и компактности программы действий постпроцессора; 

• параметры, определяющие формат кадра, начала и конца УП, 
подготовительные и вспомогательные функции и другие харак-
теристики управляющей программы, задаются в специальных 
настроечных таблицах (диалоговых окнах), что дополнительно 
упрощает проектирование и модификацию (редактирование) 
постпроцессора.  Во многих случаях для разработки нового 
постпроцессора достаточно выполнить изменения в диалоговых 
окнах постпроцессора, взятого в качестве аналога; 

• с помощью специальных таблиц можно описать геометрию и 
взаимное расположение исполнительных органов и узлов стан-
ка с ЧПУ. Это обеспечивает автоматический расчет значений 
линейных и поворотных координат станка для каждого текуще-
го положения инструмента, чем облегчается разработка пост-
процессоров для многокоординатного оборудования с ЧПУ. 
Описание станка можно просматривать и редактировать в гра-
фическом режиме; 

• наиболее сложные алгоритмы постпроцессирования встроены в 
ядро IMSpost, что избавляет разработчика от необходимости 
решать такие задачи, как проблема нелинейности при многоко-
ординатной обработке, замена серий “мелких” участков линей-
ных перемещений на участки с круговой или сплайновой ин-
терполяцией и др. 
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IMSpost позволяет быстро и эффективно создавать постпроцессоры 
для любых видов оборудования с ЧПУ – фрезерных обрабатывающих 
центров, многокоординатного оборудования, электроэрозионных и то-
карных станков. Генерируемые с помощью IMSpost постпроцессоры яв-
ляются автономными системами и используют в качестве входной ин-
формации данные в формате CLDATA, которые подготавливаются 
CAM-системой. IMSpost адаптирован к форматам CLDATA многих 
CAD/CAM-систем, в числе которых: CATIA, Cimatron, Euclid, 
MasterCAM, PowerMill,  Pro/Engineer, SurfCAM, Unigraphics. 

В качестве входной информации IMSpost использует файлы с дан-
ными о перемещениях инструмента (CLDATA) и преобразует их в УП, 
готовые для выполнения на фрезерных, токарных и электроэрозионных 
станках, машинах лазерной резки, листопробивных прессах и других ви-
дах оборудования с ЧПУ. 

При генерации УП для конкретного оборудования IMSpost исполь-
зует файл проекта (project file) (рис. 35). Файл проекта содержит боль-
шое число настроечных таблиц, которые легко корректируются через 
Windows-интерфейс IMSpost. Для дополнительной детальной настройки 
используется макроязык IMS, который может поддерживать наиболее 
сложные особенности и возможности современного оборудования с 
ЧПУ. 

 Рис. 35. Схема работы IMSpost 
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Диалоговые окна 

Эти окна являются средством параметрической настройки пост-
процессора. Они вызываются выбором соответствующей опции меню 
или нажатием на соответствующую иконку инструментальной панели 
IMSpost. Диалоговые окна позволяют, в частности, настроить: 

• вывод нужной информации в начале и конце УП; 
• правила задания в УП команд смены инструмента, охлаждения, 

коррекции инструмента, подачи, оборотов шпинделя, сверлиль-
ных циклов; 

• правила задания перемещений при линейной, круговой и сплай-
новой интерполяции; 

• порядок нумерации кадров УП; 
• правила разбиения УП на части, с учетом имеющегося размера 

памяти системы ЧПУ; 
• состав адресов кадра УП, порядок их вывода в кадре и правила 

задания информации под каждым адресом; 
• правила задания подпрограмм; 
• состав и правила задания подготовительных и вспомогательных 

функций (G- и М-функций), их разбиение по группам; 
• описание состава, характеристик и взаимного расположения ис-

полнительных органов (осей) станка. 
В качестве примера на рис. 36 приведено диалоговое окно IMSpost 

для настройки формирования постпроцессором команд круговой интер-
поляции. Здесь можно указать, какие G-функции используются для за-
дания направления движения по и против часовой стрелки, способ зада-
ния начальной точки дуги (относительно конечной точки, относительно 
центра, с помощью радиуса), минимальное и максимально допустимое 
значение радиуса при круговой интерполяции (в противном случае вы-
полняется линейная аппроксимация дуги), точность линейной аппрок-
симации, наличие или отсутствие ограничения системы ЧПУ на распо-
ложение дуги в одном квадранте (при наличии ограничения будет вы-
полнена разбивка дуги по квадрантам), возможность задания круговой 
интерполяции в произвольной плоскости. 

Диалоговые окна IMSpost отличаются большим числом различных 
параметров и продуманными наборами их вариантов, которые учитыва-
ют самые разнообразные способы задания команд УП в различных мо-
делях оборудования с ЧПУ. Тем не менее, никакая параметрическая на-
стройка не гарантирует того, что разрабатываемый постпроцессор смо-
жет учесть все особенности конкретного оборудования с ЧПУ. Единст-
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венным гарантированным способом здесь является использования языка 
программирования. 

 

Рис. 36. Диалоговое окно IMSpost для настройки команд круговой ин-
терполяции 

Макро язык и макросы 

В IMSpost используется высокоуровневый язык программирова-
ния (макроязык), с помощью которого описываются правила преобразо-
вания траектории движения инструмента, заданной в файле CLDATA, в 
управляющую программу. Программы на макроязыке (макросы) состав-
ляются так, что каждому виду оператора CLDATA соответствует свой 
макрос. При вызове постпроцессора он последовательно обрабатывает 
операторы файла CLDATA с помощью своих макросов и формирует ко-
манды УП. 
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Операторы макроязыка IMSpost позволяют передавать параметры, 
использовать локальные и глобальные переменные, работать с внешни-
ми файлами, получать доступ к параметрам оборудования с ЧПУ (за-
данным в диалоговых окнах), выполнять арифметические и логические 
операции, использовать тригонометрические и другие стандартные ма-
тематические функции, выполнять условные и безусловные переходы, 
работать с текстовыми строками и др. 

Группа операторов макроязыка IMSpost представляет собой спе-
циальные функции, реализующие достаточно сложные вычислительные 
процедуры, например замену серий «мелких» участков линейных пере-
мещений на участки с круговой или сплайновой интерполяцией. 

При создании нового постпроцессора в него автоматически вклю-
чается набор макросов по умолчанию. Эти макросы можно редактиро-
вать, удалять или заменять, импортируя макросы из других постпроцес-
соров. Отладка макросов производится с помощью отладчика (Debugger) 
IMSpost, который позволяет выполнять макросы в пошаговом режиме, 
просматривать текущие состояния локальных и глобальных переменных 
и т.д. В качестве теста для отладки может использоваться файл 
CLDATA, сформированный CAD/CAM-системой, или любой набор опе-
раторов CLDATA, набранный в текстовом редакторе. 

Макросы устанавливают связь между входными операторами 
CLDATA и формируемой постпроцессором управляющей программой. 
Вы используете программирование макросов для определения внутрен-
ней логики вашего проекта, от которой зависят решения по формирова-
нию тех или иных последовательностей кадров, которые соответствуют 
требованиям оборудования с ЧПУ и особенностям его эксплуатации на 
предприятии. 

Макрос IMS представляет собой последовательность операторов, 
которые задают для базы знаний IMS правила, как реагировать на полу-
ченную входную информацию. Каждый макрос начинается с имени 
макроса (оператора определения) и заканчивается оператором RETURN. 
Следующий пример иллюстрирует простейший макрос: 

TEST/* 
 GLOBAL.VAR = 2.5 
 REGISTER.X.VALUE = GLOBAL.VAR 
 OUTPUT(REGISTER.X, NEWLIN) 
RETURN 
В данном примере макрос имеет имя TEST. Второй и третий опера-

торы являются примерами использования арифметических выражений. 
Четвертый оператор – это пример макрооператора вывода OUTPUT. 
Макрос заканчивается оператором RETURN. 
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Арифметические операции 

Порядок, в котором операции выполняются в выражении, зависит 
от их расположения  и приоритета. Например, оба этих выражения: 

2 * 3 + 4  4 + 2 * 3 
дают в результате значение 10, так как операция умножения имеет 

более высокий приоритет и выполняется первой. Две операции с одина-
ковым приоритетом выполняются в порядке слева направо. Установле-
ны следующие приоритеты: 

* , / высший 
+ , -  
AND  
OR  
= , < , > низший 

Для задания порядка выполнения операций могут использоваться 
круглые скобки ( ). Терм выражения, заключенный в скобки, вычисляет-
ся первым. Например, выражение (4 + 2) * 3 равно 18, а не 10. Исполь-
зуйте скобки в сложных выражениях, чтобы сделать порядок вычисле-
ний более очевидным. 

Математические функции 

Допускается использование в выражениях следующих математиче-
ских функций: 

Функция Описание 
SIN(X) Синус Х (X в град) 
COS(X) Косинус Х (X в град) 
TAN(X) Тангенс Х (X в град) 
ASIN(X) Арксинус X 
ACOS(X) Арккосинус X 
ATAN(X) Арктангенс X 
ATAN2(X) Обратный тангенс частного от деления ар-

гументов 
SQRT(X) Квадратный корень от X 
ABS(X) Абсолютная величина X 
INT(X) Целая часть X (X может быть также сим-

вольной строкой) 
SINH(X) Гиперболический синус X 
COSH(X) Гиперболический косинус X 
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TANH(X) Гиперболический тангенс X 
EXP(X) Экспонента  
LOG(X) Натуральный логарифм 
LOG10(X) Десятичный логарифм (X > 10) 
POW(X,Y) X в степени Y;   A = POW(2,3) означает 

A=2*2*2 
CEIL(X) Наименьшее целое, не меньше чем X 
FLOOR(X) Наибольшее целое, не больше чем X 
MIN(X1,..,Xn) Выбор наименьшего X 
MAX(X1..,Xn) Выбор наибольшего X 
UCASE(S) Регистр прописных букв для строки S 
LCASE(S) Регистр строчных букв для строки S 
STRLEN(S) Длина строки S 
SPRINT(Form

at, V1,..Vn) 
Отформатированная строка  

MOD(X,Y) Остаток от деления X/Y со знаком X 

Примечание: вы не можете использовать в макросах имена пере-
менных, совпадающие с именами математических функций. Эти имена 
зарезервированы в IMSpost. 

Операторы присваивания 

Операторы присваивания являются наиболее распространенным 
видом операторов, используемых в макросах. Эти операторы имеют сле-
дующий формат: 

Переменная = Выражение 
Где выражение может быть простым или сложным, лишь бы оно 

порождало правильный результат. 
Макросы IMS используют два типа переменных: локальные и гло-

бальные. Локальные переменные используются только внутри конкрет-
ного макроса; глобальные переменные доступны в любом макросе пост-
процессора. Имена глобальных переменных должны начинаться со сло-
ва GLOBAL. Вы можете индексировать переменные любого из этих ти-
пов. 

Примеры: 
X = CLDATAN.1 GLOBAL.OX + GLOBAL.TX 
 MODE.COOLNT = "MIST" 
 PTR1 = LOCATE("G98") 
 a=1 
 tool = cldatan.1 + offset 
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 global.rpm = cldatan.right.rpm 
 delta = sqrt ((X*X) + (Y*Y)) 
 global.tool[t] = cldatan.1 
Не разрешается использовать символы точки (.), запятой (,), оди-

нарных или двойных кавычек в именах локальных переменных. Система 
использует эти символы в качестве разделителей и для распознавания 
имен переменных и текстовых строк. 

В операторе присваивания макроязыка вы можете задавать или из-
менять переменную так, что изменение будет действовать только в те-
кущем макросе. Когда выполнение текущего макроса завершено, значе-
ние переменной будет возвращено к ее значению до “разового” измене-
ния. Это “разовое” изменение достигается с помощью записи символа ‘!’ 
перед переменной в операторе присваивания. Например: 

TEST/* 
 GLOBAL.A  = 3.0Set variable GLOBAL.A 
* Set GLOBAL.A using "one-shot" 
 !GLOBAL.A = 999.999  
*  Set VALUE_1 to equal –999.999 
 VALUE_1 = GLOBAL.A * (-1.0) 
RETURN 
В данном примере переменная GLOBAL.A равна 999.999, пока она 

внутри макроса. После завершения работы макроса, она восстанавливает 
значение, равное 3. 

Классы переменных 

Для контроля переменных и управления ими в базе знаний, какие из 
них находятся на хранении, к каким есть доступ внутри макроса, а какие 
передаются из одного макроса в другой. Вам нужно понимать принципы 
использования переменных в макроязыке IMS. В нем существуют раз-
личные классы переменных: 

SYSTEM База знаний IMS создает и поддерживает сис-
темные переменные. Вы получаете к ним доступ с 
использованием зарезервированного слова SYSTEM 
перед именем переменной (например, 
SYSTEM.DATE). К этим переменным можно полу-
чить доступ всегда в любом макросе.  

GLOBAL Вы создаете и поддерживаете глобальные пере-
менные. Для этого используйте зарезервированное 
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слово GLOBAL перед именем переменной (напри-
мер, GLOBAL.TEST). После того как вы определили 
глобальные переменные, их можно использовать в 
любом макросе. 

MODE Определяйте эти переменные с использованием 
слова MODE для группы и подгруппы (например, 
MODE.MOTION or MODE.MOTION.LINEAR). В 
макросе вы получаете доступ к текущему состоянию 
переменной или ее функциональной подгруппы так 
же, как в случае глобальной переменной.  

LOCAL Вы можете создавать и поддерживать локальные 
переменные. Однако Вы можете использовать их 
только в том макросе, где Вы их определили. Для за-
дания локальных переменных не используется заре-
зервированное слово; вы просто задаете имя пере-
менной (например, TEST1). После выполнения мак-
роса, все локальные переменные считаются далее не 
определенными. Чтобы использовать их повторно, 
вы должны снова определить их в другом макросе 
или макросах. 

CLDATA Эти переменные являются разновидностью сис-
темных переменных. Система устанавливает значе-
ния этих переменных на время текущего выполнения 
макроса в зависимости от входных аргументов или 
информации CLDATA, передаваемой в макрос. Этот 
тип переменных поддерживается двумя зарезервиро-
ванными словами: CLDATAN (числа) и CLDATAM 
(вспомогательные слова).  

CLREAD Эти переменные являются разновидностью сис-
темных переменных. Система устанавливает значе-
ния этих переменных на время текущего выполнения 
макроса в зависимости от входных аргументов или 
информации CLDATA, которая найдена оператором 
CLREAD при просмотре входной информации “впе-
ред”. Этот тип переменных поддерживается двумя 
зарезервированными словами: CLREADN (числа) и 
CLREADM (вспомогательные слова). 

REGISTER Эти переменные соответствуют адресам кадра, 
которые определяются в таблице Register Format ta-
ble. Например, REGISTER.Z.MAXIMUM = 5000.
Полный список этих переменных приведен в HELP 
файле 
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COMPONENT Переменные, связанные с описанием узлов 
станка в диалоговом окне Machine Components. Пол-
ный список этих переменных приведен в приложе-
нии к данному руководству. 

SOLUTION Переменные, связанные с программами 
SOLUTION. Обратитесь к описанию макрооператора 
SOLUTION с примерами переменных (документация 
находится во вкладке Help). 

FUNCTION Переменные, связанные с описанием функций 
системы ЧПУ в диалоговом окне Function Definition. 
Эти переменные могут определять любое поле дан-
ного диалогового окна, например: 
FUNCTION.G1.NAME=”G1” 
FUNCTION.G1.USE=”X,Y,Z,S,F,M” 
FUNCTION.G4.USE1=”P”  (USE1 означает один 
кадр) 
FUNCTION.G0.USE=FUNCTION.G0.USE+,”AAA” 
(добавляет строку “AAA” в поле USE) 

MACHINE Переменные, связанные с описанием осей стан-
ка в диалоговом окне Machine Motion. Вы можете 
изменять любое из значений, например, 
MOTION.Z.HOME=3000.. 

Работа с макросами 

Каждый проект или постпроцессор включает свой собственный на-
бор макросов. Когда вы начинаете новый проект, то он автоматически 
включает в себя набор макросов по умолчанию. Диалоговое окно Macro 
Manager отображает только те макросы, которые содержатся в открытом 
проекте. 

В диалоговом окне Macro Manager вы можете импортировать мак-
росы из другого проекта в открытый проект. У вас также имеется опция 
для добавления макроса, только в этом случае вы можете вставить его, 
если макрос существует в другом проекте. 
Макросы IMS имеют синтаксис высокоуровневого языка программиро-
вания. Компоненты языка включают: 

• Передачу параметров 

• Определяемые пользователем процедуры (макросы) 

• Доступ к внешним файлам или программам 

• Локальные и глобальные переменные 
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• Условные операторы и операторы циклов 

• Доступ к параметрам системы ЧПУ и станка 

• Возможность обрабатывать входные операторы APT/CL 
(CLDATA) 

• Функции для чтения и записи в файлы 

• Функции предварительного просмотра 

• Арифметические, тригонометрические и логарифмические функ-
ции 

Просмотр макросов 

1. Создайте новый или откройте существующий проект. 
2. Выберите опцию Macro Manager из меню General для открытия 

диалогового окна Macro Manager. Вы можете также использовать 

клавиши Ctrl M или нажать иконку Macros  на инструменталь-
ной панели. Система отобразит на экране набор макросов, которые 
имеются в активном проекте (постпроцессоре). 

Редактирование макросов 

1. Создайте новый или откройте существующий проект. 
2.  Выберите опцию Macro Manager из меню General для открытия 

диалогового окна Macro Manager (рис. 37). Вы можете также исполь-

зовать клавиши Ctrl M или нажать иконку Macros  на инстру-
ментальной панели.  

3. Выберите макрос и нажмите кнопку Edit. Можно также дважды 
щелкнуть мышью на нужном макросе. Когда выбранный макрос поя-
вится на экране, он будет включать выбор команд File, Edit и Tab. 
Вы можете выбрать более одного макроса при нажатой клавише Shift 
или используя клавишу Ctrl. 
• File – вы можете сохранить или отменить сделанные вами измене-

ния 
• Edit – доступны операции Undo, Cut, Copy и Paste 
• Tab – автоматическое форматирование с целью упрощенного вво-

да. Нажатие Tab будет форматировать макрос с отступами для оп-
ределенных операторов, таких как IF, WHILE и CASE. 

4. Отредактируйте макрос или его описание и сохраните изменения 
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Рис. 37. Окно Macro Manager 
5. с помощью выбора опции Save меню File окна редактирования мак-

роса. 

Удаление макросов 

1. Создайте новый или откройте существующий проект. 
2.  Выберите опцию Macro Manager из меню General для открытия 

диалогового окна Macro Manager. Вы можете также использовать 

клавиши Ctrl M или нажать иконку Macros  на инструменталь-
ной панели.  

3. Выберите удаляемый макрос и нажмите кнопку Delete . 
4. Подтвердите удаление нажатием ответа Yes. 

Создание макроса 

1. Создайте новый или откройте существующий проект. 

2.  Выберите опцию Macro Manager из меню General для открытия 
диалогового окна Macro Manager. Вы можете также использовать 
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клавиши Ctrl M или нажать иконку Macros  на инструменталь-
ной панели.  

3. Нажмите кнопку New . 

4. Введите имя макроса и нажмите ОК. Вам не нужно добавлять символ 
‘/’ к имени макроса. Система добавит его автоматически. 

5. Введите операторы макроса в открывшееся окно редактирования 
макроса. Вы можете также вводить описание макроса. По завершении 
сохраните макрос с помощью выбора опции Save меню File окна ре-
дактирования макроса. 

Примечание: по умолчанию, когда вы сохраняете новый макрос, 
система добавляет к имени групповой символ ‘*’. Этот символ инструк-
тирует постпроцессор выбирать в файле CLDATA все главные слова с 
таким же именем. Например, PROBE /* принимает все операторы 
PROBE из файла CLDATA. 
Вы можете сделать вызовы макроса более специальными. Например, 

PROBE/# - должно иметься то же самое значение 
PROBE/#,#,XOFF,# - значение, значение, вспомогательное слово 

XOFF, значение 
PROBE/ZOFF,* - вспомогательное слово ZOFF с чем-либо, иначе 

следующий оператор. 
Помните, что если какой-либо из операторов CLDATA не входит в 

число просматриваемых вашим макросом, то он будет игнорироваться. 

Импорт макроса 

1. Создайте новый или откройте существующий проект. 
2. Нажмите кнопку Import для открытия окна Open Import File (рис. 38). 
3. Выберите проект, который содержит макросы, которые вы хотите 

импортировать и нажмите Open или дважды щелкните мышью на 
имени файла. 

4. В открывшемся диалоговом окне Import Macro (рис. 39) выполните 
любое из следующих действий: 
• Нажмите All для выбора всех макросов 
• Нажмите None для отмены выбора всех макросов 
• Нажмите View для просмотра выбранного макроса 
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• Отметьте окошко Verify для выдачи подтверждения в случае, если 
импортируемый макрос уже содержится в открытом проекте 

 

Рис. 38. Окно Open Import File 

 

Рис. 39. Окно Import Macro 
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5. Нажмите ОК для импорта выбранных макросов. 
Конкретные макросы, которые вы выбрали, копируются из старого 

проекта в текущий проект. 
Примечание: При выборе более одного макроса нажмите клавишу 

Ctrl и выполняйте групповой выбор. 

Поиск Макросов 

Кнопка поиска Search  дает вам возможность ввести символь-
ную строку. Система отобразит все области в активном постпроцессоре, 
где будет найдена эта строка. 
1. Создайте новый или откройте существующий проект. 
2.  Выберите опцию Macro Manager из меню General для открытия 

диалогового окна Macro Manager. Вы можете также использовать 

клавиши Ctrl M или нажать иконку Macros  на инструменталь-
ной панели.  

3. Нажмите кнопку Search . В появившемся окне (рис. 40) поиска 
введите текст строки, которую вы хотите найти. Нажмите кнопку 
Find. Система выполнит просмотр всех разделов на предмет содержа-
ния данной строки и отобразит их в таблице. Вы можете последова-
тельно просмотреть результаты поиска и перейти в конкретный мак-
рос, сделав двойной щелчок мышью на выбранном пункте. 

4. Отметьте окошко Match Case, если вы хотите, чтобы система искала 
далее только в том списке, который был найден (выше или ниже). 

5. Отметьте окошко Match complete word, если вы хотите, чтобы систе-
ма использовала при поиске полную строку. Если нет, то система бу-
дет находить и отображать все места, где заданная строка была най-
дена. 
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Рис. 40. Окно поиска Macro Search 

Модель станка и её использование 

Описание модели станка (состава, характеристик и взаимного рас-
положения исполнительных органов) наиболее важно для многокоорди-
натного оборудования, так как избавляет разработчика постпроцессора 
от необходимости решения ряда нетривиальных математических задач. 
Напомним, что при многокоординатной обработке текущее положение 
инструмента в траектории описывается в виде (x, y, z, i, j, k), где (x, y, z) – 
координаты центра торца инструмента, а (i, j, k) – орты, определяющие 
положение оси инструмента в системе координат детали. Постпроцессор 
должен (например, для 5-координатного станка с тремя линейными ося-
ми X, Y, Z и двумя поворотными осями B, C) выполнить преобразование 
(x, y, z, i, j, k)  (X, Y, Z, B, C), что требует от разработчика постпроцес-
сора вывода соответствующих математических зависимостей. Те разра-
ботчики, которые сталкивались с подобной задачей, знают, что ее реше-
ние требует значительных усилий, особенно при отсутствии опыта. 

В IMSpost эта задача решается принципиально иначе, благодаря на-
личию модели станка. Для создания модели необходимо описать в диа-
логовых окнах состав осей станка (окно Machine Motion), состав и пара-
метры узлов станка (окно Machine Components) и взаимное расположе-
ние узлов станка (окно Machine Reference). На основе этих описаний 
IMSpost формирует пространственную модель станка, которую можно 
просматривать и редактировать в графическом режиме (рис. 41). При 
работе постпроцессора текущие координаты исполнительных органов 
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станка определяются на основе заданного текущего положения инстру-
мента автоматически, благодаря использованию модели. Для получения 
координат станка (в макросе обработки перемещений инструмента) ис-
пользуется специальный оператор макроязыка. 

Модель станка позволяет автоматически решать еще одну сложную 
задачу – так называемую проблему нелинейности. Проблема состоит в 
том, что последовательные положения в траектории инструмента рас-
считываются в CAD/CAM из предположения линейности перемещения 
инструмента между этими положениями. Однако, используемый в сис-
темах ЧПУ режим линейной интерполяции при отработке кадра приво-
дит к тому, что инструмент движется по криволинейной траектории 
(рис. 42,а). В результате этого возможны зарезания и брак обрабатывае-
мой детали. 

Решение проблемы нелинейности является функцией постпроцес-
сора и заключается в следующем. Если отклонение инструмента от ли-
нейной траектории превышает заданный допуск, то постпроцессор фор-
мирует дополнительное положение инструмента в середине текущего 
участка, удовлетворяющее условиям линейности. После этого рассчиты-
вается отклонение для каждого из полученных участков (рис. 42,б). Если 
отклонение еще превышает допуск, то производится дополнительное 
деление и т.д., до тех пор, пока отклонение не окажется меньше допуска. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Рис. 41. Схема формирования координат исполнительных органов 
станка в постпроцессоре IMSpost 
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Проблема нелинейности является значительно более сложной зада-
чей, чем расчет координат исполнительных органов станка. Кроме того, 
при ее “прямом” решении путем написания соответствующей програм-
мы, возникают достаточно высокие требования к используемым средст-
вам программирования.  Далеко не все генераторы постпроцессоров 
имеют в своем распоряжении такие средства. 

 

Рис. 42. Проблема нелинейности и схема ее решения 

В генераторе IMSpost наличие модели станка позволяет решать 
проблему нелинейности автоматически. При этом, для получения масси-
ва дополнительных промежуточных точек, в макросе обработки пере-
мещений инструмента используется специальный оператор макроязыка. 
Допуск отклонения от линейной траектории устанавливается в макросе 
инициализации, который выполняется в начале работы постпроцессора. 

Конечно, освоение генератора IMSpost, как и любой серьезной сис-
темы, требует определенных усилий. Однако, эти усилия быстро окупят-
ся за счет резкого сокращения времени проектирования постпроцессо-
ров. Кроме того, с помощью IMSpost разработчик постпроцессоров по-
лучает возможность оперативно учитывать практически любые требова-
ния и пожелания цеховых технологов к поступающим управляющим 
программам. 
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Содержание отчёта 

Результатом проделанной работы студента, является выполнение 
полученного задания. 

Отчет должен содержать в себе: 
• Исходные данные; 
• Схему кинематики станка 
• Описание выполнения 
• Выходные данные 

Самостоятельная работа «Разработка технологиче-
ского процесса изготовления детали в PDM системе 
SMARTEAM» 

Разработка технологических процессов в PDM-
системе 

Современное производство использует самый широкий спектр тех-
нологий при изготовлении деталей изделий. При неавтоматизированной 
подготовке производства, технологические процессы разрабатываются 
непосредственно в виде комплектов технологической документации. 
При использовании автоматизированных систем ТПП, создаваемые опи-
сания технологических процессов размещаются в компьютерной базе 
данных, а соответствующая документация является лишь отображением 
внутреннего представления ТП во внешнюю сферу. Хранящиеся в ком-
пьютерной базе ТП являются основным источником информации для 
решения задач автоматизированного управления технологической под-
готовки производства. При этом разработка ТП выполняется с помощью 
специальных систем автоматизированного проектирования ТП (САПР). 

Автоматизация проектирования технологических процессов обес-
печивается путем разработки специальных приложений на основе ис-
пользования инструментальных средств PLM. Эти приложения должны 
быть тесно интегрированы с PDM-системой с целью обеспечения рабо-
ты технолога в среде ЕИП, а также с целью устранения дублирования 
баз данных по технологическому оборудованию, оснастке и инструмен-
ту. Такая интеграция, в частности, может быть достигнута за счет непо-
средственной реализации функций проектирования ТП в среде PDM-
системы средствами API. Практическая реализация такой САПР ТП вы-
полнена средствами API PDM-системы SMARTEAM.  
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При проектировании ТП в PDM-системе SMARTEAM используют-
ся следующие группы классов: 

• Проекты ; 

• Технологические процессы ; 

• Оборудование ; 

• Инструменты и оснастка ; 

• Материалы ; 

• Нормативно-технологическая документация . 
Проектируемый ТП формируется в виде некоторой информацион-

ной модели. Благодаря реализованному в PMD SMARTEAM объектно-
ориентированному подходу информационная модель ТП  не содержит в 
себе непосредственно тех данных, которые были «взяты» из базы при 
проектировании ТП (например, наименования операций  и переходов, 
сведения о режущем инструменте, нормативно-справочная информация 
и др.). Она содержит в себе только ссылки – специальные указатели на 
местоположение этих данных. Это позволяет исключить ненужное дуб-
лирование информации. Любое изменение элемента базы данных (на-
пример, наименования приспособления или инструкции по технике 
безопасности) приводит к тому, что эта информация автоматически «за-
меняется» во всех разработанных ТП. Тем самым автоматически обес-
печивается соответствие информации, содержащейся в ТП, информации 
различных разделов базы данных 

Заполнение базы данных (сведениями по оборудованию, оснастке, 
инструменту, наименованиям операций и переходов) может осуществ-
ляться двумя способами: 

a) непосредственным занесением информации пользователем (в ин-
терактивном режиме) в соответствующие разделы базы данных; 

b) автоматическим занесением информации в базу данных, в процес-
се разработки индивидуальных ТП. 
Второй метод применяется тогда, когда технолог при проектирова-

нии ТП не нашел в базе данных необходимой информации, и вынужден 
ввести ее в ТП вручную. В этом случае он может дать команду на запись 
введенной информации в базу данных. Такое занесение избавляет поль-
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зователей от необходимости повторного ввода данных в интерактивном 
режиме и способствует постепенному автоматическому формированию 
базы данных. 

Проектируемый в PDM SMARTEAM ТП,  представляется в виде 
дерева, основными узлами которого являются номера операций и номера 
переходов, в состав созданных объектов вводят наименования операций, 
их содержание, оборудование и другие компоненты выполняемых тех-
нологических операций и переходов.  

Технологический процесс представляется в системе в виде древо-
видной структуры, узлами которой являются номера операций и номера 
переходов, в состав этих объектов вводят наименования операций, их 
содержание, оборудование и другие компоненты ТП. Проектирование 
ТП выполняется как стандартный процесс построения дерева проекта 
(рис. 43).  

 

Рис. 43. Структура технологического процесса в PDM SMARTEAM 

Можно добавлять, удалять или заменять узлы дерева, описывать их 
конкретные характеристики. При этом определяется последовательность 
операций в маршрутном ТП, последовательность переходов в операци-
онных ТП, выбирается необходимое оборудование, приспособления и 
инструмент, указываются режимы обработки. Все эти действия осуще-
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ствляются с использованием соответствующих разделов базы данных. 
Например, при добавлении в дерево ТП новой операции, технологи вы-
бирает наименование операции из предлагаемого системой списка. При 
выборе, например, режущего инструмента для перехода «Точить по-
верхность», технолог просматривает списки имеющихся резцов и т.д. 

Для проектирования ТП в PDM SMARTEAM разработан специаль-
ный графический интерфейс (рис. 44), использование которого позволя-
ет: 

 

Рис. 44. Общий вид графического интерфейса 

• обеспечить наглядное представление структуры ТП в соответст-
вии с требованиями стандартов ЕСТД; 

• показать оптимальную последовательность описания ТП; 
• упростить и ускорить процесс, за счет повышения эргономично-

сти. 
Средства настройки системы SMARTEAM позволяют реализовы-

вать так называемый направленный поиск информации. Этот поиск ис-
пользуется при автоматическом формировании списков данных, кото-
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рые предлагаются технологу при решении задач выбора оборудования, 
оснастки, технологических переходов и других элементов ТП. Направ-
ленный поиск позволяет получать такие списки, которые «не содержат 
ничего лишнего». Так при выборе оборудования в токарной операции 
предлагается только список токарных станков (но не фрезерных или 
электроэрозионных), при выборе очередного перехода в токарной опе-
рации предлагаются только возможные для данной операции переходы и 
т.д. пользователь может сам легко связывать те или иные группы объек-
тов для обеспечения направленного поиска. 

После того, как проектирование ТП завершено, выполняется его 
нормирование и ТП поступает на утверждение. Комплект технологиче-
ских документов (ТД) размещается в классе «Технологическая докумен-
тация» и включает в себя маршрутную карту (описание маршрута), опе-
рационные карты (описание операций), ведомость оснастки (перечень 
используемых средств технологического оснащения) и ряд других доку-
ментов, оформленных в соответствии с ЕСТД. По запросу пользователя, 
комплект ТД или отдельные документы могут быть выведены на печать. 

Вся необходимая текстовая и текстово-графическая технологиче-
ская документация по требуемым формам формируется автоматически 
на основании созданного ТП. По запросу технолога в БД создается объ-
ект, все атрибуты которого заполняются автоматически, после чего к 
нему прикрепляется файл созданного документа. Все технологические 
документы собираются в комплекты.  

Некоторые технологические документы по своему содержанию яв-
ляются не текстовыми, а текстово-графическими (графическими). К та-
ким документам относятся карта эскизов, карта наладки и карта заказа 
оснастки. 

Формирование графических документов ТП осуществляется в два 
этапа: 

a) Проектирование графического изображения (эскиза) в CAD-
системе или его сканирование с готового чертежа. 

b) Формирование текстовой части документа на соответствующем 
макете бланка и включение графического изображения в документ 
в PDM-системе. 
Для карт эскизов в системе должны быть созданы объекты с при-

крепленными файлами эскизов, выполненными в одной из CAD-систем. 
При проектировании эскизов могут быть заимствованы модели или чер-
тежи изделий, разработанные конструктором. Вывод ТД на печать воз-
можен по одному документу или комплектами. Система поддерживает 
стандарты ЕСТД, а также допускает возможность настройки на пользо-
вательские форматы документов. 
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Если в ТП используется оборудование с ЧПУ, то технолог создает 
заказ на проектирование управляющих программ (УП) обработки дета-
лей. Подразделение, занимающееся проектированием УП, может ис-
пользовать геометрические модели деталей, разработанные конструкто-
ром, или модели с предыдущих операций данного ТП. Управляющие 
программы для оборудования с ЧПУ, разработанные в CAD/CAM-
системе, также являются “частью” ТП механообработки. А именно, каж-
дая управляющая программа (УП) является “частью” соответствующего 
операционного ТП для станка с ЧПУ. Поэтому УП присутствуют в об-
щей модели ТП и хранятся в классе “Технологические процессы”. Кроме 
того, оформленные на бланках тексты УП хранятся в классе “Техноло-
гическая документация”.  

Технологические процессы по различным видам обработки данного 
изделия могут разрабатываться параллельно вне зависимости от общей 
технологической последовательности, но затем имеющийся в системе 
механизм поддержки "сквозных" технологических процессов позволяет 
объединить эти ТП в единый технологический маршрут и автоматически 
вывести общую маршрутную карту. 

Так можно сформировать информационную модель изделия, вы-
пускаемого предприятием. Фрагмент информационной модели изделия 
приведен на рис. 45. 

Вся информация, полученная в ходе проектирования и технологи-
ческой подготовки производства изделия, хранится в БД и в дальнейшем 
может быть передана в системы управления производством MRP/ERP 
через специальные интерфейсы, имеющиеся в PDM-системе SmarTeam. 
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Рис. 45. Информационная модель проекта 
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Задание 

В данной работе студентам необходимо самостоятельно разрабо-
тать технологический процесс изготовления детали при помощи средств 
PDM-системы SMARTEAM.  

Для проектирования технологического процесса в PDM-системе 
SMARTEAM необходимо выполнить следующую последовательность 
действий: 

1. Создать объект «деталь». 
2. Создать заготовку. 
3. Указать материал. 
4. Спроектировать расцеховку. 
5. Сформировать маршрут изготовления детали. 
6. Описать операции и переходы. 
7. Занести в базу PDM-системы SMARTEAM оборудование и инст-

рументы, необходимые для изготовления детали. 
8. Сформировать комплект технологической документации. 

Результатом выполнения работы является технологический процесс, 
сформированный в PDM-системе SMARTEAM. Набор технологической 
документации: маршрутная карта, операционная карта. Каждая опера-
ционная карта должна содержать описание переходов и операционный 
эскиз.  

Проектирование технологического процесса 

Создание ТП осуществляется методом индивидуального проекти-
рования, который заключается в ручной компоновке необходимых по-
следовательностей операций и переходов с использованием имеющихся 
в системе библиотек. Они содержат списки наименований операций и 
переходов, перечни применяемого оборудования, приспособлений, ре-
жущего, вспомогательного и мерительного инструмента. Индивидуаль-
ное проектирование предполагает также возможность использования 
разработанных ранее ТП в качестве аналогов. При этом проектирование 
сводится, по существу, к редактированию уже имеющегося ТП. 

Библиотеки наименований и содержания операций, оборудования, 
оснастки и инструмента, вспомогательных материалов и других компо-
нентов ТП доступны по «горячим клавишам» в пределах всей базы дан-
ных. Каждый новый компонент ТП, введённый любым из технологов в 
"свой" ТП, автоматически добавляется в соответствующую библиотеку 
и может быть заимствован любым другим технологом для нового ТП. 
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В общем случае проектирование технологического процесса в 
SMARTEAM можно представить состоящим из следующих этапов: 

1. Создание проекта. 
2. Создание детали. 
3. Создание заготовки. 
4. Разработка ТП.  
5. Наполнение базы данных инструмента и технологического обору-

дования. 
6. Проектирование технологической документации.  
Отображение дерева ТП со всеми логическими связями. 

Создание объекта «деталь» 

Прежде, чем начать проектирование технологического процесса, 
необходимо в PDM-системе SMARTEAM создать объект «деталь». За-
тем передать данные (обозначение и наименование детали) в ТП, ис-
пользуя кнопку, находящуюся на странице паспорта детали 

. Это необходимо проделать для того, 
чтобы система присвоила уникальный номер данному ТП и его операци-
ям, что позволит избежать дублирования данных во всей системе. 

Создание заготовки 

На данном этапе в состав детали включается заготовка при помощи 

кнопки , расположенной на титульном листе 
данной детали. 

При создании объекта «Заготовка»  автоматически устанавливается  
логическая связь этого объекта с «Проектом (изделием)», количество за-
готовок принимается равным единице и автоматически вводится на 
страницу Composition.  

Далее требуется назначить материал, который используется для из-
готовления детали. Выбор всех материалов производится из библиотек 
материалов. Информацию о материалах заготовок вводят на закладке 
«Титульный лист-Расчет М на заготовку». Активизация кнопки «Вы-
брать материал» выводит на экран классификатор материалов. На рис. 
46 приведено окно, содержащее перечень материалов SMARTEAM. 

Для того чтобы начать проектировать ТП необходимо перейти в 
класс ТП созданной вами детали. Как уже говорилось ранее, для проек-
тирования ТП разработан специальный графический интерфейс (рис. 
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44), расположенный на закладке «Титульный лист – хТП». Так как на 
первом этапе была осуществлена передача данных в ТП, в классе ТП ав-
томатически сформировались два объекта:  

a) папка «Сумма технологий с обозначением проекта»; 
b) техпроцесс «Расцеховка». 

 

Рис. 46. Перечень материалов 

Проектирование «расцеховок» 

Объект – «расцеховка» (Рц) на стадии технологической подготовки 
производства изделий создается автоматически в составе папок  «Сумма 
технологий» в группе классов «Технологические процессы»  при акти-
визации программы «Передать данные в ТП», «кнопка» запуска кото-
рой расположена на ТЛ изделий. При помощи графического интерфейса 
для проектирования ТП, формируется «расцеховка» – последователь-
ность цехов изготовителей, которая задается при помощи кнопки «№ 
этапа». 

После создания этапов, используя кнопку  
необходимо получить «Межцеховой маршрут». После выполнения дан-
ной операции «Межцеховой маршрут» появится в дереве ТП.  
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Проектирование «сквозного» ТП  

В системе SMARTEAM существует два способа проектирования 
ТП: 

• Проектирование «сквозных» ТП; 
• Проектирование ТП по методам обработки. 

«Сквозной» ТП - это ТП одного из методов обработки, в котором 
описана еще и общая технологическая последовательность обработки 
изделия по всем методам обработки. 

Проектирование ТП по методам обработки – это ТП, в котором 
формируются последовательность операций и переходов всех методов 
обработки, входящих в состав данного ТП. 

Технологический процесс формируется при помощи кнопки «Но-
мер сквозного ТП или ТП метода обработки». 

На данном этапе выполнения работы необходимо ввести следую-
щие данные: 

• Вид ТП по охвату. 
• Вид ТП по организации. 
• Вид ТП по методу обработки. 

Проектирование операций и переходов 

При помощи кнопки «№ операции» в дерево проекта добавляется 
операция, которой присваивается свой уникальный номер, сформиро-
ванный из наименования и кода операции, согласно ГОСТ 3.1201. На 
рис. 47 приведен классификатор операций в PDM-системе SMARTEAM. 

Затем устанавливаются необходимые логические связи операции со 
следующими объектами: 

• *А – наименование операции; 
• *Б – оборудование из группа классов «Оборудование» (ОБ); 
• *И – инструкция из группы классов «Нормативно-

технологическая документация» (НТД); 
• *ИОТ – инструкция по охране труда из группы классов НТД; 
• "ТТ" – техническое требование в начале ТП операции; 
• О – содержание формообразующей операции (перехода); 
• ОВ – содержание вспомогательной операции (перехода); 
• ОУ – вспомогательной операции (перехода) установки-снятия; 
• К – комплектация оригинальных изделий из группы классов 

«Проекты» (ПР) 
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• Кпи – комплектация покупных изделий из группы классов «По-
купные изделия» (ПИ); 

• М – материал из группы классов «Материалы» (М); 
• Р – режим обработки из группы классов «Режимы обработки» 

(РО); 
• ТТ – техническое требование в конце ТП операции; 
• ЦУ – примечание (указание) в конце операции; 
• Т – инструменты (оснастка) покупные из группы классов «Инст-

румент, оснастка» (ИО).  

 

Рис. 47 Классификатор операций 

Для создания переходов в SMARTEAM необходимо указать его со-
держание и тип. На рис. 48 приведен классификатор переходов.  
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Рис. 48. Классификатор переходов 

 Возможные типы переходов: 
• у – установка-снятие; 
• в – вспомогательный; 
• рг – рабочий грубый (черновой); 
• рпч – рабочий получистовой; 
• рч – рабочий чистовой. 

Примечание. 1. Объекты – строки описания, «привязанные» к 
«дереву» ТП иерархическими связями, отображаются 
черным цветом. 
2. Объекты – строки описания логически «привя-
занные» к «дереву» ТП, отображаются зеленым цве-
том. 
3. Символ (* – «звездочка») перед кодом строки Б, 
И, ИОТ  предназначен для поддержки последова-
тельности строк описания ТП в «дереве» ТП в соот-
ветствии с требованиями стандартов ЕСТД при сор-
тировке «дерева» командами: «Сортировать → По 
обозначениям → По возрастанию». 
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Наполнение базы данных инструментов и техноло-
гического оборудования 

Внешний вид окна, содержащего перечень инструмента и оснастки, 
представлен на рис. 49. В случае отсутствия в системе SMARTEAM не-
обходимого технологического оборудования, его требуется создать са-
мостоятельно. Для наполнения базы данных инструментов и оборудова-
ния следует зайти в классы с соответствующими названиями Оборудо-

вание  и Инструменты и оснастка . Затем в дереве проек-
тов создать необходимое оборудование (инструмент/оснастку).  Это по-
зволит значительно сократить время на разработку, так как заведенные 
объекты могут в дальнейшем использоваться для проектирования техно-
логического процесса.  

 

Рис. 49. Перечень инструмента, оснастки в PDM-системе SMARTEAM 

Проектирование технологической документации 

Формирование маршрутной карты осуществляется активизацией  
соответствующей кнопки (МК), расположенной на титульном листе 
СквТП, ТП по методам обработки и  титульном листе изделия. В при-
ложении  1 приведен пример маршрутной карты, полученной в 
SMARTEAM. 

Текстовая технологическая документация по требуемой форме и 
карты эскизов формируются автоматически. По запросу технолога на 
вывод требуемого технологического документа в базе данных автомати-
чески создается паспорт этого документа, заполняются все поля паспор-
та и формируется файл информации в виде этого документа. Получен-
ный таким образом документ может быть проверен, утвержден и сдан в 
электронный архив. Для вывода карт эскизов в базу данных должны 
быть введены файлы эскизов, выполненные в одной из CAD-систем.  
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При проектировании эскизов могут быть заимствованы модели или 
чертежи изделий, разработанные конструктором. Вывод на печать воз-
можен по одному документу или комплектами. Система поддерживает 
стандарты ЕСТД, однако в системе имеются все средства для разработки 
программ вывода документации по любой форме силами пользователей. 

Сформированные таким образом документы могут быть проверены, 
утверждены и сданы в электронный архив.  

Создание операционных карт.  Технологическую документацию 
вводят в состав объектов «№ операции». На титульном листе объектов 
«№ операции» необходимо выбрать «Ввести объект «Документ техно-
логический», при активизации данной опции на экран выводится спи-
сок, из которого можно выбрать: ОК; Оки; ОКк; КЭ; КН; КС; КК; ТО. 
Для формирования операционной карты в предложенном списке необ-
ходимо указать ОК. 

Для формирования ОК с эскизом необходимо выполнить следую-
щие операции: 

1. Выбрать опцию «Ввести объект эскиз» в состав требуемого доку-
мента. 

2. Создать эскиз (изображение изделия) в CAD-системе или на куль-
мане с последующим сканированием. 

3. Привязать файл эскиза в формате *.gif к объекту «Эскиз техноло-
гический»; 

4. Выбрать опцию «Сформировать ТК», после чего файл эскиза бу-
дет автоматически объединен с файлом бланка ТК  и общий файл 
привязан к объекту ТК. 
При проектировании эскиза в CAD-системе файл эскиза можно со-

хранить в  SMARTEAM и в формате CAD-системы для последующего 
редактирования, и в формате *.gif для создания ТК с эскизом.  

• Путь к файлу в формате CAD-системы вводят стр. «Автор+Файл» 
паспорта объекта «Эскиз технологический» и просматривают на 
стр. «Просмотр». 

• Путь к файлу в формате *.gif вводят на ТЛ паспорта и просматри-
вают на стр. «Эскиз в формате *.gif». 
В SMARTEAM существует возможность формировать документы 

без эскиза для этого необходимо выбрать кнопку «Сформировать ТК». 
При этом  система задает вопрос: «Вы хотите сформировать ТК без эс-
киза?». При ответе «Да»  выбранная КТ будет автоматически сформиро-
вана на соответствующем бланке. 

В приложении 2 приведен пример операционной карты, полученной 
в SMARTEAM. 
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На последнем этапе выполнения работы рекомендуется отобразить 
в дереве ТП логические связи со всеми созданными объектами. Для это-
го из контекстного меню ТП следует выбрать команду Привязанные 
объекты>Логические связи … 

Отображение дерева ТП со всеми логическими свя-
зями 
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Рис. 49 Отображение логических связей проектов с ТП 

 

 



Приложение 1 
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В 2007 году СПбГУ ИТМО стал победителем конкурса инноваци-

онных образовательных программ вузов России на 2007–2008 годы. Реа-
лизация инновационной образовательной программы «Инновационная 
система подготовки специалистов нового поколения в области инфор-
мационных и оптических технологий» позволит выйти на качественно 
новый уровень подготовки выпускников и удовлетворить возрастающий 
спрос на специалистов в информационной, оптической и других высоко-
технологичных отраслях экономики. 
 

КАФЕДРА ТЕХНОЛОГИИ ПРИБОРОСТРОЕНИЯ 
 

Кафедра технологии приборостроения относится к числу ведущих 
кафедр института со дня его основания в 1931 году. Тогда она называлась 
кафедрой механической технологии и возглавлялась известным ученым в об-
ласти разработки инструмента профессором А.П. Знаменским. Позже она бы-
ла переименована в кафедру технологии приборостроения. 

За время своего существования кафедра выпустила из стен института 
более тысячи квалифицированных инженеров, более сотни кандидатов и 
докторов наук. В разные годы ее возглавляли известные ученые и педагоги 
профессора Николай Павлович Соболев и Сергей Петрович Митрофанов. 

Кафедра имеет выдающиеся научные достижения. Заслуженным 
деятелем науки и техники РСФСР, профессором С.П. Митрофановым 
были разработаны научные основы группового производства, за что он 
был удостоен Ленинской премии СССР. Методы группового 
производства с успехом применяются в промышленности и постоянно 
развиваются его учениками. Заслуженным изобретателем Российской 
Федерации Юрием Григорьевичем Шнейдером разрабатаны метод и 
инструментарий нанесения регулярного микрорельефа на 
функциональной поверхности. 

В настоящее время кафедра осуществляет выпуск специалистов по 
специальностям "Технология приборостроения" (инженер-технолог, 
инженер-технолог-менеджер, инженер-технолог по искусственному 
интеллекту в приборостроении) и "Системы автоматизированного 
проектирования" (инженер-системотехник). На кафедре ведется 
подготовка бакалавров, магистров, инженеров и аспирантов по 
названным специализациям силами семи профессоров и девяти 
доцентов. 
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	 Оглавление 
	 Самостоятельная работа «Верификация технологических операций сборки» 
	Цель работы 
	Введение 
	1. Запустите систему DELMIA. 
	2. Перейдите к модулю DPM Assembly Process Simulation (меню Start / Digital Process for Manufacturing / Assembly Process Simulation), рис. 1. 
	  
	3. В данном задании ресурсы будут добавляться из каталога. 
	4. Щелкните на иконке Catalog Browser (рис. 2). 
	  
	Нажав на кнопку browse another catalog, выберите каталог ../Dassault Systemes / B17 / intel_a / startup / components / facility / furniture.catalog             (рис. 3). 
	  
	Из открывшегося каталога выберите стол work_bench 72x36x34. 
	Добавьте два таких стола и расположите их относительно друг друга, как показано на рисунке ниже. 
	  
	Из каталога My_Catalog.catalog (находится в папке с данными для самостоятельной работы) добавьте стул (chair) и тележку для инструментов (toolcart). 
	Добавьте используемый инструмент – гаечный ключ (wrench) и отвертку (screwdriver). Расположите компоненты относительно друг друга, как показано на рис. 5. 
	Далее необходимо добавить изделие (продукт) в созданное окружение. 
	Для этого воспользуйтесь командой Insert Product в меню Insert или на панели инструментов. 
	  
	В открывшемся окне проводника Windows выберите файл 3.5 HP engine.CATProduct в папке с данными для самостоятельной работы (Project Data/ Product). 
	Расположите изделие (3.5 HP engine.CATProduct) на рабочем столе (рис. 6). 
	  
	Сохраните созданное рабочее место в папку, указанную преподавателем. 
	Выберите команду Create New Activity   и назовите “Engine assembly” (Сборка двигателя). 
	Выберите команду Create New Activity Subtype   для создания подтипов операций. 
	Создайте следующие подтипы (операций): 
	  
	Сохраните вашу библиотеку операций в папку, указанную преподавателем (например, …/ Project Data / my process library). 
	Далее ассоциируем созданную библиотеку с процессом сборки (Process). Для этого необходимо воспользоваться инструментом Insert Activity Library   и указать Process в дереве проекта, после чего выбрать ранее созданную библиотеку. 
	Это необходимо для того, чтобы при задании операций система предлагала нам список операций из библиотеки. 
	Этап 3. Формирование перечня технологических операций (последовательности сборки) 
	Следующим этапом работы является формирование последовательности сборки. Это делается путем добавления технологических операций (Activity) в дерево проекта (в ветвь Process).  
	Как правило, последовательность формируется в обратном порядке (т.е. производится разборка изделия), а после этого порядок операций меняется на противоположный. 
	Для добавления операций воспользуйтесь инструментом Insert Activity  , щелкните на Process и выберите Engine Assembly в появившемся диалоговом окне. 
	Далее с помощью того же инструмента добавьте Block Assy, выбрав тип вставки Add As child (вставить, как потомка). 
	Затем добавьте остальные операции, выбирая тип вставки Add As Successor (вставить, как последующий элемент). Последующий элемент (Sacsessor) должен быть связан с предыдущей операцией, а не с Engine Assembly.  
	Теперь необходимо проверить правильность последовательности операций и при необходимости изменить ее. Сделать это можно с помощью диаграммы планирования с использованием сетевого графика (PERT chart). 
	Щелкните на иконке Open Pert Chart   , а затем на Process в дереве проекта. Откроется сетевой график вашего процесса. Раскройте полностью график, нажав “+” в правом верхнем углу Engine Assembly.  
	  
	Стрелки обозначают связи между операциями. Задайте последовательно связи между всеми  операциями,  используя инструмент  Link Selected Activities  . 
	Ваш процесс должен выглядеть, как показано ниже. 
	  
	С помощью диаграммы планирования можно задавать параллельные процессы, используя логические операции. 
	Теперь необходимо сопоставить операциям соответствующие детали, т.е. указать системе какая именно деталь (или сборка) устанавливается на данной операции. Для этого выделите подсборку Block Assembly в дереве проекта (ветвь ProductList), щелкните на иконке  Assign an item  , а затем на операции Block Sub Assembly (ветвь ProcessList). 
	Раскройте ветвь Block Sub Assembly в дереве, чтобы убедиться, что операция проведена успешно. 
	Задание траектории перемещения компонентов является одним из ключевых моментов при создании технологических процессов сборки.  
	Поскольку мы работаем в виртуальной среде, то перемещение любого компонента может быть создано независимо от других компонентов. После чего может быть проведен анализ на столкновения и взаимные пересечения компонентов.  
	Зададим траектории перемещения для следующих компонентов:  
	 Cover (Кожух) 
	 Air Filter (Воздушный фильтр)  
	Выполните следующую последовательность действий: 
	1. Выделите операцию, для которой вы хотите задать перемещение. 
	2. Создайте перемещение с помощью инструмента Move Activity   и выберите тип вставки as child. 
	3. Убедитесь, что в окне предварительного просмотра выбрана правильная деталь (сборка), нажмите OK в окне Edit Shattle. 
	4. Перетащите деталь в сторону от двигателя, используя компас. 
	5. Зафиксируйте положение, нажав кнопку Record  . 
	6. Повторяйте предыдущее действие, пока не уложите деталь на стол. 
	7. Фиксируйте каждое положение детали, нажав на кнопку Record. 
	8. Используйте панель инструментов Player для отмены и просмотра перемещений. 
	9. Когда убедитесь, что деталь имеет необходимое положение (лежит на столе), закройте диалоговое окно Track и повторите те же действия для других деталей. 
	После того, как траектории построены для необходимых деталей, мы можем посмотреть симуляцию всего процесса и определить места возникновения проблемных участков, представляющих собой столкновения компонентов и их взаимное пересечение. 
	Включите опцию Clash Detection (Stop)  , запустите симуляцию процесса, используя команду Compile Simulation:  . 
	После чего запустите симуляцию, используя панель Player:   
	Система должна автоматически определить столкновения компонентов и остановить симуляцию в момент возникновения конфликта, подсветив красным цветом место столкновения (рис. 10). 
	  
	Этап 5.Формирование файла отчета 
	Формат файла отчета настраивается для каждого конкретного предприятия в соответствии с его стандартами и потребностями. 
	В рамках данной работы предлагается воспользоваться стандартной формой файла отчета, поставляемой с дистрибутивом системы DELMIA. 
	Вся необходимая документация генерируется системой на основе скриптов (CATScript, VBScript), что дает практически неограниченные возможности по заданию формы отчетов, формата (и выводу всех необходимых параметров). Для вывода файла документации воспользуйтесь инструментом Generate Documentation  . 
	В появившемся диалоговом окне выберите скрипт, нажав на кнопку Browse. Путь к файлу (рис. 11):  
	../CATIA/B17/intel_a/code/command/DocumentGeneratorHTML_WNT_DPMWorkImages.CATScript. 
	  
	В поле Path укажите путь для сохранения файла отчета и имя в поле Main File Name. Нажмите OK  для создания файла отчета. На следующем рисунке представлен пример такого отчета. 
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